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Important User Information Because of the variety of uses for the products described in this
publication, those responsible for the application and use of these
products must satisfy themselves that all necessary steps have been
taken to assure that each application and use meets all performance
and safety requirements, including any applicable laws, regulations,
codes and standards. In no event will Allen-Bradley be responsible or
liable for indirect or consequential damage resulting from the use or
application of these products.

Any illustrations, charts, sample programs, and layout examples
shown in this publication are intended solely for purposes of
example. Since there are many variables and requirements associated
with any particular installation, Allen-Bradley does not assume
responsibility or liability (to include intellectual property liability) for
actual use based upon the examples shown in this publication.

Allen-Bradley publication SGI-1.1, Safety Guidelines for the
Application, Installation and Maintenance of Solid-State Control
(available from your local Allen-Bradley office), describes some
important differences between solid-state equipment and
electromechanical devices that should be taken into consideration
when applying products such as those described in this publication.

Reproduction of the contents of this copyrighted publication, in whole
or part, without written permission of Rockwell Automation, is
prohibited.

Throughout this publication, notes may be used to make you aware of
safety considerations. The following annotations and their
accompanying statements help you to identify a potential hazard,
avoid a potential hazard, and recognize the consequences of a
potential hazard:

WARNING Identifies information about practices or
circumstances that can cause an explosion in a
hazardous environment, which may lead to personal
injury or death, property damage, or economic loss.

Identifies information about practices or
circumstances that can lead to personal injury or
death, property damage, or economic loss.

ATTENTION

g g

IMPORTANT Iden_tifie_s information that ig critical for successful
application and understanding of the product.




ATTENTION

Environment and Enclosure

This equipment is intended for use in a Pollution
Degree 2 industrial environment, in overvoltage
Category Il applications (as defined in IEC
publication 60664-1), at altitudes up to 2000 meters
without derating.

This equipment is considered Group 1, Class A
industrial equipment according to IEC/CISPR
Publication 11. Without appropriate precautions,
there may be potential difficulties ensuring
electromagnetic compatibility in other environments
due to conducted as well as radiated disturbance.

This equipment is supplied as "open type"
equipment. It must be mounted within an enclosure
that is suitably designed for those specific
environmental conditions that will be present and
appropriately designed to prevent personal injury
resulting from accessibility to live parts. The interior
of the enclosure must be accessible only by the use
of a tool. Subsequent sections of this publication
may contain additional information regarding
specific enclosure type ratings that are required to
comply with certain product safety certifications.

See NEMA Standards publication 250 and IEC
publication 60529, as applicable, for explanations of
the degrees of protection provided by different types
of enclosure. Also, see the appropriate sections in
this publication, as well as the Allen-Bradley
publication 1770-4.1 ("Industrial Automation Wiring
and Grounding Guidelines"), for additional
installation requirements pertaining to this
equipment.




Rockwell Automation
Support

Rockwell Automation offers support services worldwide, with over 75
sales/support offices, 512 authorized distributors and 260 authorized
systems integrators located throughout the United States alone, as well
as Rockwell Automation representatives in every major country in the
world.

Local Product Support

Contact your local Rockwell Automation representative for:

« sales and order support
* product technical training
 warranty support

* support service agreements

Technical Product Assistance

If you need to contact Rockwell Automation for technical assistance,
please review the troubleshooting information first. If the problem
persists, then call your local Rockwell Automation representative.

Your Questions or Comments on this Manual

If you find a problem with this manual, please notify us of it on the
enclosed How Are We Doing form.

Allen-Bradley is a trademark of Rockwell Automation
ControlLogix is a trademark of Rockwell Automation

SynchLink is a trademark of Rockwell Automation



Preface

About This Preface

This preface describes how to use this manual. The following table
describes what this preface contains and its location.

For information about:

See page:

Who Should Use This Manual

Preface-1

Purpose of This Manual

Preface-1

Related Products and Documentation

Preface-4

Who Should Use You must be able to program and operate an Allen-Bradley

This Manual

ControlLogix™ Logix controller and ControlLogix I/0 modules to
efficiently use your SynchLink™ module.

We assume that you know how to do this in this manual. If you do
not, refer to Related Documentation, before you attempt to use this

module.

IMPORTANT SynchLink should be used in conjunction with a
standard control network, such as ControlNet or

Ethernet. A standard network is used for general
control interlocking and transfer of diagnostic data

across the system.

SynchLink does not function as a standard control
network (e.g. it broadcasts data in a unidirectional

manner).

Purpose of This Manual This manual describes how to install, configure, and troubleshoot
your ControlLogix SynchLink module.
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What This Manual Contains This user manual contains the following sections:

Chapter 1 - What is the
1756-SYNCH module?
Description of the SynchLink module

Chapter 3 - SynchLink Module
Features
Description of the SynchLink module
certifications and general features

Chapter 5 - Configuring the
SynchLink Module

Description of how to configure the
SynchLink module with RSLogix 5000

Publication 1756-UM521A-EN-P - August 2001

Chapter 2 - Time Synchronization in the
ControlLogix System
Description of how the SynchLink module
synchronizes time in the ControlLogix system

Chapter 4 - Installing the SynchLink
Module
Description of how to install the SynchLink
module and connect the fiber optic cable

Chapter 6 - Troubleshooting the
SynchLink Module
Description of how to troubleshoot
the SynchLink module

SynchLink

LINK 3 CJLINK
COMM SYNC

ok

&\
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Appendix A - Specifications Appendix B - Configuring the Star
Listing of the SynchLink module Configuration
specifications Example of how to configure the

SynchLink Star Configuration

&

Appendix C - Configuring the Appendix D - Configuring the Ring Appendix E - Software
Daisy Chain Configuration Configuration Configuration Tags
Example of how to configure the Example of how to configure the Complete list of all the input and
SynchLink Daisy Chain Configuration SynchLink Ring Configuration output data tags

&\
Il

Glossary Index
Glossary of terms used with the Index of terms and concepts explained
SynchLink module thoughout this user manual
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Related Products and
Documentation

Publication 1756-UM521A-EN-P - August 2001

The following table lists related ControlLogix products and
documentation:

Table Preface.A
Related Documentation

Catalog Document title: Pub. number;

number:

1756-SYNCH | ControlLogix SynchLink Module Installation 1756-IN575
Instructions

1756-A4, -A7, | ControlLogix Chassis Installation Instructions 1756-IN080B

-A10, -A13

1756-PA72, ControlLogix Power Supply Installation Instructions | 1756-5.67

-PB72

1756-PAT5, ControlLogix Power Supply Installation Instructions | 1756-5.78

-PB75

1756-Series | ControlLogix Module Installation Instructions Multiple 1756-IN
(Each module has separate installation document.) | numbers

1756-Series | ControlLogix System User Manual 1756-UM001

Multiple SynchLink Design Guide 1756-TD008

numbers

1751-SLBA SynchLink Base Block Installation Instructions 1751-IN001

1751-SL4SP | SynchLink 4-port Splitter Block Installation 1751-IN002
Instructions

1751-SLBP SynchLink Bypass Switch Block Installation 1751-IN003
Instructions

1756-DM ControlLogix Drive Module Installation Instructions | 1756-IN577

1756-DM ControlLogix Drive Module User Manual 1756-UM522
PowerFlex 700S User Manual 20D-UM001

If you need more information on these products, contact your local
Allen-Bradley integrator or sales office for assistance. For more
information on the documentation, refer to the Allen-Bradley
Publication Index, publication SD499.



Table of Contents

What is the 1756-SYNCH module?

Time Synchronization in the
ControlLogix System

SynchLink Module Features

Chapter 1

What is the ControlLogix SynchLink Module?. . ......... 1-1
What Data Does the SynchLink Module Transfer? . . . .. 1-1
Why Synchronize Time Between Chassis?. . .. ....... 1-2
What Are Some of the Features Available On the
ControlLogix SynchLink Module? .. ............... 1-2

Connecting a SynchLink Module to a SynchLink System ... 1-3
Physical Features of the ControlLogix SynchLink Module 1-4

Using Module Identification and Status Information . . . . .. 1-5
Preventing Electrostatic Discharge . . . ................ 1-7
Removal and Insertion Under Power . . ............... 1-7
Chapter Summary and What's Next . . ................ 1-8
Chapter 2
Using the Coordinated System Time (CST). ............ 2-2
Time Synchronization in a Distributed Control System . ... 2-2
Time Synchronization in the SynchLink System ......... 2-2
SynchLink Node Clock. . ....................... 2-3
How Do the CST Clock and SynchLink Node Clock Work
Together? . .. ... . . . . 2-5
Configuring Time Mastership Functionality. . .. ......... 2-6
What are the SynchLink Configurations?. . . ............ 2-8
Star Configuration .. ........... .. ... ... ....... 2-8
Daisy Chain Configuration . . .................... 2-9
Ring Configuration. . . ......................... 2-10
CableUsage ......... ... ... . .. 2-11
Chapter Summary and What's Next . . ................ 2-11
Chapter 3
General Module Features. . . ........ ... ... .. ... ... 3-1
Removal and Insertion Under Power (RIUP) . ... ..... 3-2
Module Fault Reporting . . .. ............ ... ..... 3-3
Fully Software Configurable . . ................... 3-3
LED Status Information. . . . ..................... 3-3
Class | Division 2 Certification .. ................. 3-4
Agency Certification. . . ............. ... ........ 3-4
Configurable Module Features. . .. .................. 3-4
Communications Format. . .. .................... 3-5
Electronic Keying. . .. ........ ... .. . 3-9
Requested Packet Interval . ..................... 3-11
SynchLink Transmitted Axes. . .. ................. 3-13
Transmitted Direct Words. . .. ................... 3-14
CST and SynchLink Mastership. . .. ............... 3-16
Chapter Summary and What's Next . . . ............... 3-16

Publication 1756-UM521A-EN-P - August 2001



Table of Contents i

Installing the SynchLink Module

Configuring the SynchLink Module

Troubleshooting the
SynchLink Module

Publication 1756-UM521A-EN-P - August 2001

Chapter 4
Noting the Power Requirements . ................... 4-1
Installing the Module. . . .......................... 4-2
Connecting the Fiber OpticCable . .................. 4-3
Removing the Module. . . ......................... 4-4
Chapter Summary and What's Next . . ................ 4-5
Chapter 5
Overview of the Configuration Process ............... 5-2
Choose a SynchLink Configuration. . ... .............. 5-3
Star Configuration.. . . .......... ... .. .. .. ..... 5-3
Daisy Chain Configuration.. . . ................... 5-3
Ring Configuration. .. .............. ... ........ 5-3
Create a New RSLogix 5000 Project. . . ............. 5-4
Add a SynchLink Module . . . .................... 5-5
Configure the SynchLink Module .. ............... 5-6
Download Configuration . .. .................... 5-8
Changing Configuration After Module Operation Has Begun 5-9
Chapter Summary and What's Next . . ................ 5-10
Chapter 6
Using the Status Indicators. . . ...................... 6-1
Using RSLogix 5000 to Troubleshoot the Module . .. ... .. 6-3
Determining Fault Type . . .. .. ... . ... .. ... ..... 6-5
Using Diagnostic Counters. . .. ..................... 6-6
Message Instructions . ......................... 6-7
Message Configuration. . . ...................... 6-8
Retrieving and Resetting Diagnostic Counters. . ......... 6-11
Chapter Summary and What's Next . .. ............... 6-11



Table of Contents iii

Specifications

Configuring the Star Configuration

Configuring the Daisy Chain
Configuration

Configuring the Ring Configuration

Software Configuration Tags

Glossary

Index

Appendix A
Appendix B
Using Remote Axis Control .. ...................... B-2
Configure Time Master Chassis - Master Node. . . ... .. B-2
Configure Time Slave Chassis - End Node. . ......... B-8
Configure Time Slave Chassis - End Node. .. ....... B-13
Appendix C
Configure Time Master Chassis - Master Node. . . ... .. C-2
Configure Time Slave Chassis - Center Node. .. ... ... C-7
Configure Time Slave Chassis - End Node. . ... ... .. C-12
Appendix D
Configure Time Master Chassis - Master Node. . . ... .. D-2
Configure Time Slave Chassis - Center Node. .. ... ... D-7
Configure Time Slave Chassis - End Node. .. ....... D-12
Appendix E
Accessingthe Tags . . ......... .. E-2
InputDataTags .. ........ .. E-3
OutputData Tags . . . .. .ot o i e E-4

Publication 1756-UM521A-EN-P - August 2001



Table of Contents iv

Publication 1756-UM521A-EN-P - August 2001



Chapter 1

What is the ControlLogix
SynchLink Module?

What is the 1756-SYNCH module?

This chapter describes the ControlLogix SynchLink module. It also
describes iwhat you must know and do before using the SynchLink
module.

For information on: See page:
What is the ControlLogix SynchLink 1-1
Module?

Connecting a SynchLink Module to a 1-3
SynchLink System

Using Module Identification and Status 1-5
Information

Preventing Electrostatic Discharge 1-7
Removal and Insertion Under Power 1-7
Chapter Summary and What's Next 1-8

A ControlLogix SynchLink module, through the use of fiber optic
communication technology, allows you to implement:

« time synchronization
« distributed motion control
» coordinated drive control

based on the ControlLogix and PowerFlex 700S platforms. In
distributed control system, the SynchLink module broadcasts reference
data and synchronizes time from a single ControlLogix chassis to
multiple other chassis at a high speed.

What Data Does the SynchLink Module Transfer?

The SynchLink module transfers multiple types of reference data
between chassis, including:

» Produced axis data for chassis to chassis remote axis control
» High speed drive reference data for chassis to drive control

» General control information that requires transfer at a high
speed and in a synchronized manner
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Why Synchronize Time Between Chassis?

In synchronizing time between chassis, the SynchLink module allows
you to:

 share motion data from chassis to chassis because a consistent
time reference is available among chassis for interpolation of
velocity and position data.

* timestamp 1/0 in multiple chassis and have a common time
reference with which to compare the timestamps.

For more information on how the SynchLink module impacts the time
references between ControlLogix chassis, see Chapter 2, Time
Synchronization in the ControlLogix System.

What Are Some of the Features Available On the ControlLogix
SynchLink Module?

The following are some of the features available on the ControlLogix
SynchLink module:

» Support of multiple SynchLink system configurations - Star, daisy
chain and ring

For more information on these functions, see Chapter 2, Time
Synchronization in the ControlLogix System For more
information on how to configure the module with RSLogix 5000,
see Chapter 5, Configuring the SynchLink Module.

» Removal and insertion under power (RIUP) - This system feature
allows you to remove and insert the module while power is
applied. For more information on RIUP, see page 1-7.

e Communication of remote axis data in a timely and
deterministic manner

« Communication of direct and buffered data

* Class | Division 2, UL, CSA, and CE Agency Certification
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Connecting a SynchLink
Module to a SynchLink
System

ControlLogix SynchLink modules mount in a ControlLogix chassis and
connects to other SynchLink node through a fiber optic cable system.

For more information on the available fiber optic cables,
see Table 1.A.

Table LA

Fiber Optic Cables Available with the 1756-SYNCH Module
Catalog number: Cable length Cables per box:
1403-CF001 1m (3.28ft) 2
1403-CF003 3m (9.84ft) 2
1403-CF005 5m (16.41t) 2
1403-CF010 10m (32.8ft) 1
1403-CF020 20m (65.6ft) 1
1403-CF050 50m (164ft) 1
1403-CF100 100m (328ft) 1
1403-CF250 250m (820ft) 1

When you install the SynchLink module in a Star Configuration, you
need to use hubs as well as fiber optic cables. A hub is a combination
of one base block with up to four splitter blocks. A bypass switch
block is also available for use in the daisy chain configuration. For
more information on the Star Configuration, see page 2-8.

For more information the hub components available for use with the
SynchLink module, see Table 1.B

Table 1.B

Hub Components Available with the 1756-SYNCH Module
Catalog Number: Hub Type:
1751-SLBA SynchLink Fiber Base Block
1751-SL4SP SynchLink Fiber 4-Port Splitter Block
1751-SLBP SynchLink Fiber Bypass Switch Block

For more information on SynchLink fiber optic cable systems, see The
SynchLink Design Guide, publication 1756-TD008.
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Before you install and use your module you should have already:

* installed and grounded a 1756 chassis and power supply. For
more information, refer to the publications listed in Table 1.C.

Table 1.C

Chassis and Power Supply Documentation
Catalog Document title: Pub. number:
number:
1756-A4, -A7, | ControlLogix Chassis Installation Instructions 1756-IN080
-A10, -A13
1756-PAT72, ControlLogix Power Supply Installation Instructions | 1756-5.67
-PB72
1756-PAT5, ControlLogix Power Supply Installation Instructions | 1756-5.78
-PB75
1756-PA75R/A, | ControlLogix Redundant Power Supply Installation | 1756-IN573
-PB75R/A Instructions

Physical Features of the ControlLogix SynchLink Module

Module side view Module front view
/ ( LINK LINK
comv— = syne
— D -<—— Status
] = Indicators

Backplane —r _|
Connector- Interface —
to the ControlLogix 7
system backplane |

D Tx (rear) !\"

\ § Ax (ront) SN 42744
Transmit Receive

Fiber Port Fiber Port
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Using Module
ldentification and Status
Information

Backplane Connector - The backplane connector connects the
module to the ControlLogix chassis backplane.

Status Indicators - The status indicators display the module’s
communications and SynchLink system status.

Transmit Fiber Port - The transmit fiber port allows connection (via
fiber optic cables) to other SynchLink modules so the module can
send data.

Receive Fiber Port - The receive fiber port allows connection (via
fiber optic cables) to other SynchLink modules so the module can
receive data.

Each ControlLogix SynchLink module maintains specific identification
information that separates it from all other modules. This information
assists you in tracking all the components of your system.

For example, you can track module identification information to be
aware of exactly what modules are located in any ControlLogix rack at
any time. While retrieving module identity, you can also retrieve the
module’s status.

Each module maintains the following information:

Table 1.D
Module Identification and Status Information
Module Identification: Description:
Product Type Module’s product type, such as Digital 1/0 or
Analog I/0 module
Catalog Code Module’s catalog number
Major Revision Module’s major revision number
Minor Revision Module’s minor revision number
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Table 1.D
Module Identification and Status Information
Module Identification: Description:
Status Module’s status. Returns the following information:

« Controller ownership (if any)
« Whether module has been configured
« Device Specific Status, such as:

— Self-Test

— Flash update in progress

— Communications fault

— Not owned (outputs in program mode)
— Internal fault (need flash update)

— Run mode

Minor recoverable fault
Minor unrecoverable fault
Major recoverable fault
Major unrecoverable fault

Vendor ID Module manufacturer vendor, for example Allen-Bradley

Serial Number Module serial number

Length of ASCII Text String | Number of characters in module’s text string

ASCII Text String Number of characters in module’s text string

IMPORTANT You must use tr_le WHQ _serwce m the RSLinx
software to retrieve this information. For more
information on how to retrieve module identification
information, see the RSLinx online help.
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Preventing Electrostatic This module is sensitive to electrostatic discharge.
Discharge

Preventing Electrostatic Discharge

This equipment is sensitive to electrostatic discharge,
which can cause internal damage and affect normal
operation. Follow these guidelines when you handle
this equipment:

» Touch a grounded obiject to discharge potential
static.

e Wear an approved grounding wriststrap.

« Do not touch connectors or pins on component
boards.

» Do not touch circuit components inside the
equipment.

« |f available, use a static-safe workstation.

« When not in use, store the equipment in
appropriate static-safe packaging.

Removal and Insertion These modules are designed to be installed or removed while chassis
Under Power power is applied.

WARNING When you insert or remove the module while
backplane power is on, an electrical arc can occur.

This could cause an explosion in hazardous location
installations. Be sure that power is removed or the
area is nonhazardous before proceeding.

Repeated electrical arcing causes excessive wear to contacts on both
the module and its mating connector. Worn contacts may create
electrical resistance that can affect module operation.
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Chapter Summary and In this chapter, you learned about the ControlLogix SynchLink
What's Next module. For information about Time Synchronization in the
ats Nex ControlLogix System, see Chapter 2.
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Chapter 2

Time Synchronization in the

ControlLogix System

This chapter describes how the ControlLogix SynchLink module fits in

the ControlLogix system.

For information on:

See page:

Using the Coordinated System Time (CST)

2-2

Time Synchronization in a Distributed
Control System

2-2

Time Synchronization in the SynchLink
System

2-2

How Do the CST Clock and SynchLink Node
Clock Work Together?

2-5

What are the SynchLink Configurations?

2-8

Chapter Summary and What's Next

2-11

Before you can fully understand how the SynchLink module can be
used in a distributed ControlLogix system, you should understand
how a ControlLogix application works without SynchLink. See the
ControlLogix System User Manual, publication 1756-UMO001 for a
detailed description of the ControlLogix system.

IMPORTANT

Part of this chapter describes the differences
between ControlLogix systems that do and do not

use the SynchLink module. In systems that use the
SynchLink module, a Logix controller must reside in
every chassis that contains a SynchLink module.
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Using the Coordinated
System Time (CST)

Time Synchronization in a
Distributed Control System

Time Synchronization in the
SynchLink System
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The Coordinated System Time (CST) is the clocking mechanism used
to achieve time synchronization in a ControlLogix chassis. The
ControlLogix Coordinated System Time (CST) clock is a 64-bit clock
on the backplane of the ControlLogix chassis. It has a 1uS resolution
and is used as the main time reference for all modules plugged into a
chassis backplane.

For more information on how the ControlLogix CST affects the
operation of other ControlLogix products, see the ControlLogix System
User Manual, publication 1756-UMOQ0L.

The same CST mechanism described above is also used to
synchronize ControlLogix chassis in a distributed control system. In
such a system, SynchLink transfers the CST value from the CST Master
chassis to CST Slave chassis. Each chassis must be equipped with a
SynchLink module. This distributed control system is identified as a
SynchLink system.

Time synchronization within a SynchLink system is required to:

« transfer a CST value from the CST Master chassis to CST Slave
chassis.

« transfer motion and drive control data.

* support time synchronization between ControlLogix chassis and
non-ControlLogix products (e.g. PowerFlex 700S products).

The SynchLink Node Clock is integral to all devices that contain the
SynchLink circuitry. It is the clocking mechanism on the fiber optic
side of the SynchLink system. This clock has a resolution of 1uS.

During system configuration, you establish one SynchLink node clock
as the master system clock on the SynchLink fiber. By design, the
ControlLogix chassis that is configured as the SynchLink master also
acts as the CST master of the system. In this manner, one SynchLink
node acts as a Time Master for the entire system. This chapter gives
more detail on how this functionality is accomplished.

Multiple Rockwell Automation products can be synchronized with
SynchLink. In addition to the SynchLink module, the PowerFlex 700S
and the 1756-DMxxx series products (both used for drive control) also
use SynchLink to achieve drive to drive synchronization. While all of
these products maintain interoperability, not all SynchLink features are
incorporated into every product that uses SynchLink; the 1756-SYNCH
module, however, uses all of the SynchLink features.
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SynchLink Node Clock

The SynchLink node clock is integral to the SynchLink circuit design.
Any product incorporating SynchLink incorporates the SynchLink
node clock as a base-line requirement. The SynchLink node clock has
a 1uS resolution and is synchronized from node to node when the
SynchLink system is configured.

SynchLink uses a Time Master-slave mechanism to achieve time
synchronization. During system configuration, you configure one
SynchLink node as the Time Master and all other nodes as time slaves.
The SynchLink node that is configured as Time Master becomes the
system clock for the entire SynchLink system. As such, the SynchLink
Time Master broadcasts its time reference to the SynchLink Time
Slaves which adjust their node clocks to be in phase with the

master clock.

Since SynchLink is a unidirectional, broadcasting mechanism, the
master is always placed at the beginning of a SynchLink system,
regardless of topology, as shown in Figure 2.1.

Figure 2.1
Star Configuration Daisy Chain Configuration
SynchLink
Time Master SLNC. SLNC. SLNC.
S.L.N.C. . . .
SynchLink SynchLink SynchLink
il Time Master Time Slave Time Slave 42981
Hub
v A,
S.L.N.C. S.L.N.C. S.L.N.C. S.L.N.C.
SynchLink SynchLink SynchLink SynchLink
Time Slave Time Slave Time Slave Time Slave 42980

S.L.N.C. = SynchLink Node Clock
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System Synchronization

When a SynchLink system is initialized, the individual SynchLink
nodes power-up at separate times and the individual SynchLink node
clocks begin to count at arbitrary points in time. When this occurs, the
system is not yet synchronized. As the master node clock counts, it
reaches a point where it rolls over and goes back to zero.

When the rollover occurs, the SynchLink master transmits a beacon
signal to the SynchLink time slaves; the beacon is included in the
control field of the transmitted message. When the SynchLink Time
Slave receives the first message with the beacon signal, it begins to
adjust the 1 microsecond time base of its node clock to synchronize
with the master clock. This process can be gradual or immediate,
depending on the product implementation.

Figure 2.2
Initial Start-Up
Master
Time adjustment L /I/ /‘
Slave D
Beacon Beacon Beacon 12982
Synchronized Operation
Master
Slave
42983

After a SynchLink Time Slave is synchronized with the Time Master,
each SynchLink frame that is transmitted serves as a 50uS “tick” (or
mark) used for the periodic adjustment of its clock’s 1uS time base.
This process provides highly accurate results.

Figure 2.3

Beacon signal
synchronizes

SynchLink node_—¢ ¢,
clocks
[ s B s s e

SynchLink 50 microsecond message frame —
d

serves as a “tick” to keep clocks synchronize 42984
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How Do the CST Clock and
SynchLink Node Clock
Work Together?

As stated earlier, the ControlLogix Coordinated System Time clock
(CST) is a 64-bit clock on the ControlLogix backplane. It is used as the
main time reference for all modules plugged into a ControlLogix
chassis. The SynchLink node clock is used to establish the time
reference on the SynchLink fiber.

Figure 2.4 illustrates how the SynchLink node clock and the CST time
reference are coordinated in a system. In this example, the SynchLink
modules in chassis A & B synchronize the CST clock in chassis B with
the CST reference in chassis A.

Chassis A is the Time Master for the system. When the SynchLink
module strobes the beacon signal onto the fiber optic link, it also
transmits the CST time reference value that tells the downstream node
what time it is as the beacon occurs. The downstream chassis receives
the CST time reference and synchronizes its time with the CST
reference value on the beacon signal.

Figure 2.4
Chassis A Chassis B

64-hit clock

—» Coordinated System Time Coordinated System Time

1756-SYNCH ——— |

SynchLink Node Clock ———»

ul n‘\

»
>

1756-SYNCH

Y Clock

SynchLink beacon over
the fiber optic link
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Configuring Time
Mastership Functionality
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In the example shown in Figure 2.4, you configure time mastership
for the system when initially configuring the module. In the “Module
Properties” software screens, the “Time Mastership” tab offers you the
option to select the 1756-SYNCH module as the CST Time Master for
the chassis, or, the Time Master on SynchLink. For any SynchLink
system, there can only be one Time Master for the entire system. All
other connected devices must be time slaves.

Use the following RSLogix 5000 configuration screen to establish time
mastership in Chassis A of Figure 2.4:

[ Module Properties - Local:3 [1756-5YNCH/A 1.1)
General | Connection | Associated Axes | Module Info |
SynchLink Configuration Time Mastership | Backplane
r Make this module the Coordinated ~ Make this module the Coordinated

System Time Master for the chassis. Swstem Time Master for the SynchLink.

DANGER: IF this setting is cleared
arline, &ll active serva axes in any
chagsis dependent on this

Coordinated System Time will be
turhed off.

Status: Offine T I N L

By checking the Make this module the Coordinated System Time
Master for the SynchLink box, you:

« establish the SynchLink node clock on this module as the
SynchLink Time Master.

* establish the chassis as the CST Time Master on SynchLink.

For more information on configuring your SynchLink modules,
see Chapter 5.
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You use the following RSLogix 5000 configuration screen to establish
a Time Slave in Chassis B of Figure 2.4:

[ Module Properties - Locak:3 [1756-5YHNCH/A 1.1) B
General I Connection | Aszociated bures | Module Info |
SynchLink Configuration Tirne b astership | Backplane

Make this module the Coordnated | [ [~ Make this moduke the Coordnated
iBystem Time Master for the chassis, System Time Master for the SynchLink.

DAMGER: If this setting is cleared
orling, all active servo axes in any
controller in the chassis will be
turned off

Status: Offline 0K I Cancel Apply Help

By checking the Make this module the Coordinated System Time
Master for the chassis box, you:

« establish the SynchLink module as a Time Slave on SynchLink.
« establish the module as the CST Time Master of the local chassis.

The selection shown above (i.e. Make this module the Coordinated
System Time Master for the chassis) is also optional for the CST Time
Master chassis. If this selection is NOT selected in the Time Master
chassis, another module on the backplane MUST be selected as the
CST backplane master in order to allow the master chassis to have a
CST reference value. Other modules that could be CST time masters
are ControlLogix controllers and other 1756-SYNCH modules. Only
one CST master can exist in a chassis at one time.

For more information on configuring your SynchLink modules,
see Chapter 5.
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Time Synchronization in the ControlLogix System

What are the SynchLink
Configurations?

ControlNet

SynchLink communications are a unidirectional data transfer from one
SynchLink node to another. Each configuration starts with a single
Master Node. The SynchLink network can be configured in the

following ways.

« Star Configuration

 Daisy Chain Configuration

* Ring Configuration

Do not mix the configurations (i.e. begin in the star configuration and
change to the daisy chain configuration). Examples of these

configurations are shown in the following sections.

Star Configurati

on

The star configuration transfers data from a Master Node through
Hubs to End Nodes.

A

[

&)
= o of d

e\
=
End Node

Lllies

xxxxxx
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|

: SynchLink Hub

|

| ¢ ‘ ’

|

; + +

‘ Hub Hub

|
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|

i)} o) i) i)l li:) a2} i:x)

- nl nl nl':l nl ﬂym = nl nl nl':l nl ﬂym S nl nl nl':l nl dy-: = nl nl nl l nl nle.

ri End Node 3 ri End Node 3 Ti End Node rié End Node
2 BN 2 3 e 2 S S ]
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IMPORTANT

The star configuration supports 2 layers of hubs with
up to 16 end nodes connected to each hub.

A maximum of 257 SynchLink modules (including
the Master Node) can be connected in the star
configuration.

For an example of how to configure a Star configuration, see

Appendix B.
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Daisy Chain Configuration

In the daisy chain configuration, the SynchLink network starts at the
Master Node and ends at an End Node. You can include Center Nodes
(shown in Figure ) in the configuration as needed.

@’ [8\ e\ [8) e\ [8) B [8\
SEHEEE A EERHEE=S = o o] o de. = El El E[[ El El_:_:_

E Master Node f EE Center Node E E Center Node j;” E; End Node 3
= e e e
=5 T R e I
Lo e I L _ _

SynchLink ——» ControlNet

Y Y Y w6

>
>

Y
Y

In the daisy chain configuration, you can use a
maximum of 10 nodes, including the master and
end nodes.

IMPORTANT

Also, the only difference between Center and End
Nodes is their physical location.

In the daisy chain configuration the time synchronization process is
more complicated than in the star. It's based on the following rules.

» Each node enable its transmitter right after it has received the
first message from the upstream node.

» Each node can generate and transmit the beacon signal
regardless of whether it has received one or not.

» Each node is a Time Slave of its upstream node and will attempt
to synchronize with it.

The Master node must be set as the SL Time Master. Its node clock is
the SynchLink system clock. After power-up, the Master node begins
to transmit a message every 50uS. As soon as the node connected to it
receives the first of these messages, it begins to send messages to its
downstream node. Eventually, all center nodes are transmitting
messages.

As soon as a node receives the first message with the beacon signal, it
starts to synchronize its node clock with the upstream node clock. The
node connected to the Master, is the first to synchronize its clock with
the SynchLink system clock. This process then propagates down the
daisy chain until all nodes are synchronized with the Master.

For an example of how to configure a Daisy Chain configuration, see
Appendix C.
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Ring Configuration

The ring configuration is a permutation of the daisy chain
configuration. In the ring chain configuration, the SynchLink network
starts and ends at the Master Node. You can include Center Nodes
(shown in Figure ) in the configuration as needed.

i o SEEERHENRE g o o] 8 d=.
E Master Node = E Center Node 2 E Center Node :EU
r‘géziztztzizg T B ‘%HHM
1 [EI"‘F I\ @J: u:
SynchLink ——» ControlNet
\ - Y - y -
. . v 42748

IMPORTANT T th_e ring chain configuration, you can use a
maximum of 10 nodes.

For an example of how to configure a Ring configuration, see
Appendix D.
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Chapter Summary and
What's Next

Cable Usage

You must use fiber optic cable to connect SynchLink modules in all
configurations. For more information on choosing the correct cable
lengths for your application, see the SynchLink System Overview,
publication .

In this chapter, you learned how the ControlLogix SynchLink module
fits into the ControlLogix system. For more information on SynchLink
Module Features, see Chapter 3.
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Notes:
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Chapter 3

SynchLink Module Features

This chapter describes the ControlLogix SynchLink module features.

For information on: See page:
General Module Features 31
Configurable Module Features 3-4
Chapter Summary and What's Next 3-16

General module features are features (e.g. Removal and Insertion
Under Power) that are supported on the module regardless of
configuration and application.

Configurable module features are features (e.g. Communications
Format) that can be configured to work differently in various
SynchLink applications.

General Module Features The following general module features are available with the
ControlLogix SynchLink module:

» Removal and Insertion Under Power (RIUP)
Module Fault Reporting

Fully Software Configurable

LED Status Information

Class | Division 2 Certification

» Agency Certification
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Removal and Insertion Under Power (RIUP)

All ControlLogix SynchLink modules may be removed and inserted
from the chassis while power is applied. This feature allows greater
availability of the overall control system because, while the module is
being removed or inserted, there is no additional disruption to the rest
of the controlled process.

Although there is no disruption to other devices when the SynchLink
module is removed and inserted from the chassis while power is
applied, the removal and insertion will break communications
between SynchLink modules and will impact the performance of the
SynchLink system.

Removing and reinserting the SynchLink module under power also
impacts overall system performance and operation because the
ControlLogix chassis are no longer synchronized. Depending on the
application, removing and reinserting the SynchLink module under
power may cause significant changes to an application, including the
possibility of a system E-Stop (emergency stop).

Because of its impact on other chassis, the removal of a SynchLink
module while under power may cause personal injury or property
damage.

WARNING When you insert or remove the module while
backplane power is on, an electrical arc can occur.

This could cause an explosion in hazardous location
installations. Be sure that power is removed or the
area is nonhazardous before proceeding.

Repeated electrical arcing causes excessive wear to contacts on both
the module and its mating connector. Worn contacts may create
electrical resistance that can affect module operation.
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Module Fault Reporting

ControlLogix SynchLink modules provide both hardware and software
indication when a module fault has occurred. Each module’s LED fault
indicator and RSLogix 5000 will graphically display this fault and
include a fault message describing the nature of the fault.

This feature allows you to determine how your module has been
affected and what action should be taken to resume normal operation.

Fully Software Configurable

The RSLogix 5000 software uses a custom, easily understood interface
to write configuration. All module features are enabled or disabled
through the 1/0 configuration portion of the software.

You can also use the software to interrogate any module in the system
to retrieve

* serial number

* revision information
catalog number

» vendor identification
error/fault information

By eliminating such tasks as setting hardware switches and jumpers,
the software makes module configuration easier and more reliable.

LED Status Information

The ControlLogix SynchLink module has LED indicators on the front
of the module that allow you to check the module health and
operational status.

The following status can be checked with the LED indicators:

 SynchLink and ControlLogix backplane status
* Module health status

For examples of LED indicators, see page 6-1.

Publication 1756-UM521A-EN-P - August 2001



3-4  SynchLink Module Features

Configurable Module
Features
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Class I Division 2 Certification

The ControlLogix SynchLink module is certified for use in
nonhazardous locations as well as Class I, Division 2 hazardous
Locations containing gas groups A, B, C, and D. This equipment may
be used as a component of a control system which is certified to
operate in hazardous locations.

WARNING When you insert or remove the module while
backplane power is on, an electrical arc can occur.

This could cause an explosion in hazardous location
installations. Be sure that power is removed or the
area is nonhazardous before proceeding.

Agency Certification

When the SynchLink module is marked appropriately, the following
agency certifications apply:

» UL Listed Industrial Control Equipment
» CSA Certified Process Control Equipment
» CSA Certified for Class I, Division 2 Hazardous Locations

The following SynchLink module features are configurable via
RSLogix 5000:

» Communications Format
Electronic Keying

Requested Packet Interval
SynchLink Transmitted Axes

» Transmitted Direct Words

CST and SynchLink Mastership

Each of these features is described in this section, including
information on which RSLogix 5000 configuration screen should be
used to configure the feature. For an overview of the entire
configuration process, see Chapter 5, Configuring the SynchLink
Module. For configuration examples, see the following appendices B
(Configuring the Star Configuration), C (Configuring the Daisy Chain
Configuration), and D (Configuring the Ring Configuration).
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Communications Format

The communications format defines the connection between the
owner-controller and the module (i.e. determines what type of data is
transferred between them). The SynchLink module can receive and
transmit data and, therefore, uses a Receive Port Communications
Format and Transmit Port Communications Format.

SynchLink messages that are structured as six 32-bit words; the words
are divided into three types:

* Direct - Data delivered in a single message. A SynchLink
message can contain a maximum of four direct data words; each
word is 32 bits in length. Direct data can be automatically
forwarded to the next node in the daisy chain and ring
configurations.

Direct data is typically only used in a daisy chain configuration.

 Buffered - Data that exceeds the four word limit of a direct data
transfer. Buffered data is appropriately segmented at the
transmitting module and reassembled at the receiving module.
Buffered data cannot be automatically forwarded to the next
node in the daisy chain and ring configurations.

» Axis data - Motion data used by the motion planner in the
controller. The 1756-SYNCH module can consume an Axis tag
from a controller and pass it over SynchLink. A controller in
another chassis can then consume axis tags passed over
SynchLink from the 1756-SYNCH module in that chassis. This
data is not automatically forwarded in a Daisy Chain.

Module-Defined Data Tags

When you create a module, module-defined data types and tags are
created in the RSLogix 5000 programming software. These tags allow
you to access the Input and Output Data of the module via the
controller’s ladder logic, if necessary

The types of tags created vary, depending on which communications
format you choose when creating a module. There are two types of
tags:

 Input Data Tags
* Output Data Tags

For a complete listing of all the module-defined data tags available on
your SynchLink module, see Appendix E.
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Multiple Port Communications Formats in Single Module

You must set a communications format for receiving data (Receive
Port Communications Format) and transmitting data (Transmit Port
Communications Format) in each SynchLink module.

The following requirements apply to communication format choices:

« If a SynchLink module does not receive data (e.g. a SynchLink
Time Master in a star or daisy chain configuration), you must
choose the No Receive Data Receive Port communication format.

* If a SynchLink module does not transmit data (e.g. an end
node), you must choose the No Transmit Data Transmit Port
communications format.

» The receive communication format for any SynchLink module
that receives data (i.e. is not the SynchLink Time Master) must
match the transmit communications format of the upstream node
in the system. For example, if the Time Master SynchLink
module uses a 2 Axis Transmit Port communication format, the
SynchLink module physically connected to the Time Master
must use a 2 Axis Receive Port communications format.

IMPORTANT The receive and transmit on the same module do not
have to match.

Also, once the module is created, the
communications format cannot be changed. The
module must be deleted and recreated.
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Internal Scan on SynchLink Module

Every 500uS, the SynchLink module scans its internal hardware and
captures a “snapshot” of the data there. This data is then sent to the
local owner-controller. But, depending on the communications
formats chosen during module configuration, data types are
transmitted between SynchLink nodes (via the fiber optic cable) at
various rates and may be transmitted multiple times between the
500uS snapshots.

The transfer rate times listed in Table 3.A and
IMPORTANT : .
_ Table 3.B only represent the rate at which data is

passed between SynchLink modules over the fiber
optic cable.

Although the data is passed over the fiber optic cable
at various rates, depending on the communications
format choices, the owner-controllers in each local
chassis only receive the data after the local
SynchLink module’s internal scan every 500uS.

The SynchLink module updates its receive and transmit buffers once
every 500uS. Because direct data can be passed through from node to
node once every 50uS, up to 10 nodes can be updated with direct
data in a single 500uS SynchLink scan. Pass-through functionality only
applies to direct data in a daisy chain configuration, though; axis data
and buffered data cannot be passed through. Instead, these data types
require the intervention of the local controller to move data along. For
this reason, it is not recommended that a daisy chain configuration
be used when distributing axis data among multiple axis in a
distributed control system.
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For more information on the available Receive Port and Transmit Port
communication formats, see Table 3.A.

Table 3.A
SynchLink Module Communications Formats
Receive Port Communications Format | Transfer Rate (across the fiber optic
cable) for Each Data Type:
1 Axis, 3 Direct Words, 14 Buffered Axis Data - Updated every 500pS
Direct Data - Updated every 50uS
Buffered Data - Updated every 500uS
2 Axis Axis Data - Updated every 250uS
2 Axis, 3 Direct Words Axis Data - Updated every 500uS
Direct Data - Updated every 50uS
2 Direct Words, 18 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 250uS
4 Direct Words, 18 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 500uS
4 Direct Words, 8 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 250uS
No Receive Data No data updated in this format
Table 3.B

SynchLink Module Communications Formats

Transmit Port Communications Format | Transfer Rate (across the fiber optic
cable) for Each Data Type:

1 Axis, 3 Direct Words, 14 Buffered Axis Data - Updated every 500uS
Direct Data - Updated every 50uS
Buffered Data - Updated every 500uS

2 Axis Axis Data - Updated every 250uS

2 Axis, 3 Direct Words Axis Data - Updated every 500uS
Direct Data - Updated every 50uS

2 Direct Words, 18 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 250uS

4 Direct Words, 18 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 500uS

4 Direct Words, 8 Buffered Direct Data - Updated every 50uS
Buffered Data - Updated every 250uS

Listen Only, No Transmit Data No data updated in this format

No Transmit Data No data updated in this format
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Electronic Keying

Instead of plastic mechanical backplane keys, electronic keying allows
the ControlLogix system to control what modules belong in the
various slots of a configured system.

During module configuration, you must choose one of the following
keying options for your SynchLink module:

» Exact Match
» Compatible Match
* Disable Keying

When the controller attempts to connect to and configure a SynchLink
module (e.g. after program download), the module compares the
following parameters before allowing the connection and
configuration to be accepted:

* Vendor

* Product Type
Catalog Number
» Major Revision
* Minor Revision

The comparison is made between the keying information present in
the SynchLink module and the keying information in the controller’s
program. This feature can prevent the inadvertent operation of a
control system with the wrong module in the wrong slot.

Exact Match

All of the parameters listed above must match or the inserted module
will reject a connection to the controller.

Compatible Match

The Compatible Match mode allows a SynchLink module to determine
whether it can emulate the module defined in the configuration sent
from the controller.

With ControlLogix SynchLink modules, the module can emulate older
revisions. The module will accept the configuration if the controller’s
major.minor revision is less than or equal to the physical

module’s revision.
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For example, if the configuration contains a major.minor revision of
2.7, the module inserted into the slot must have minor revision of 2.7
or higher for a connection to be made.

We recommend using Compatible Match whenever
possible. Remember, though, the module will only

> work to the level of the configuration.

For example, if a slot is configured for a module with
major.minor revision of 2.7 and you insert a module
with a major.minor revision of 3.1, the module works
at the 2.7 level despite having been previously
upgraded.

If possible, we suggest you make sure configuration
is updated to match the revision levels of all
SynchLink modules. Failure to do so may not
prevent the application from working but may defeat
the purpose of upgrading your modules’ revision
levels.

Disable Keying

The inserted module attempts to accept a connection to the controller
regardless of its type.

ATTENTION Be gxtremgly cz_iutlous _vvhen using the dlsgble
keying option; if used incorrectly, this option can

lead to personal injury or death, property damage
or economic loss.

If keying is disabled, a controller makes a connection with most
modules of the same type as that used in the slot configuration.

A controller will not establish a connection if any of the following
conditions exist, even if keying is disabled:

» The slot is configured for one module type (e.g. digital input
module) and a module of another type (e.g. SynchLink module)
is inserted in the slot.

» The module inserted into the slot cannot accept some portion of
the configuration. This case should not arise if the slot is
configured for a SynchLink module and one is inserted.
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The Communications Format and Electronic Keying features are
configured on the following screen.

Module Properties - Local:1 [1756-5YNCH/A 1.1) [ %]
Type: 1756-5YMCH /A SynchLink Interface
“Yendar: Allen-Bradley
Parert: Local
Mame: ITimeﬁMaster Slot: |3 j
Description: ;I
[

Receive Port Comm Format: INO Receive Data

Communications Formats ——

[
[

Tranzmit Port Comm Format; IT Axig, 3 Direct Wards, 14 Buffered

Bedisin [ [T = Electroric Keying: [CompetileModue | ]<——————— Electronic Keying
Cancel | < Back | Nexst » | Finish > > I Help |

Requested Packet Interval

The Requested Packet Interval (RPI) is a configurable parameter that
defines when the module multicasts its data onto the local chassis
backplane. In the SynchLink module, though, the RPI's role is dictated
by the data the SynchLink transfers.

Axis Data

The RPI does not have an effect on produced or consumed axis data.
In a distributed motion control application, the coarse planner update
establishes the timing of the axis data updates from the producing
controller to the consuming 1756-SYNCH module in the master
chassis. Likewise, in the slave chassis, the RPI parameter does not
affect the delivery of the axis data to the consuming processor. This
data is produced at the coarse update rate established in the master
chassis.
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Requested Packet Interval —————FeeavestedPackettnterarfRi®  200=]ms (20~ 750.0ms)
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Buffered, Direct and Diagnostic Data - RPI Effect on Input Data (to the
controller)

The RPI is one of two mechanisms available through the 1756-SYNCH
module to update the module’s input data onto the backplane. Input
data is transferred from the SynchLink module to its owner-controller
at the rate defined in the RPI.

In addition to the RPI, Change of State (COS) functionality also causes
the module to produce its data to the consuming controller whenever
the values of the data changes. The RPI timer is asynchronous to the
COS functionality. Both cause the module to produce data when
triggered.

Buffered, Direct and Diagnostic Data - RPI Effect on Output Data (from the
controller)

As a producing controller writes data to the 1756-SYNCH module, the
output data is placed in a local buffer until the next RPI reset occurs.
When the RPI timer expires, the output data is moved from the
controller’s local buffer to the 1756-SYNCH module.

The RPI timer is asynchronous to the program execution. Therefore, a
worst case update to the SynchLink module can be calculated by
adding the program execution time to the RPI timer setting, as
configured by the user.

The SynchLink module minimum RPI = 2.0mS. The RPI is configured
on the following screen:

Module Properties - Local:2 [1796-5YNCH/A 1.1) [x]

™ Inkibit Madule

™ Major Fault On Contraller IF Connectian Fails 'While in Fun Mods
Madule Fault

Cancel < Back Next » | Finish >3 I Help
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Transmitted Axes

SynchLink Transmitted Axes

Most applications using the ControlLogix SynchLink module use it for
Remote Axis Control. You can use the SynchLink module to produce
axes from a master chassis and broadcast the data to other chassis.
The module can produce and consume two axes (i.e. Axis 0 & Axis 1).

Slave chassis consume the broadcast axis data and redistribute it to
their local motion planners (i.e. the Logix controller in their local
chassis). With this configuration, you can control multiple axes
synchronously throughout the system.

The SynchLink Transmitted Axes are configured on the following
screen:

Module Properties - Local:3 [1756-SYNCH/A 1.1) [ x|
r— SynchLink Transmitted Axes:
Auis 0 IAppI\cation_Ams_A j J
> New Agis... |
Axis 10 | <nonex> j J
<haner

Application fuis &

Cancel < Back | Mext » | Finigh > I Help

For an example configuration that uses Remote Axis Data, see
Appendix B, Configuring the Star Configuration.

IMPORTANT This manual assumes you know how to set-_up axis
data tags for the data the controller in the Time

Master chassis produces; this manual does not intend
to explain how to plan the motion portion of your
application as that is a controller function.

If you do not know how to set-up remote axis data
tags and account for them in the motion portion of
your application, see the ControlLogix Motion
Module Setup & Configuration User Manual,
publication 1756-6.5.16.
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Transmitted Direct Words

The SynchLink module can transmit data from the following direct
word sources:

» Output Direct Words (0-3)
 Received Direct Words (0-3)
» Multiplier

In initial configuration, you can choose the Transmitted Direct Words,
but you must use ladder logic to move data to those locations in data
type tags. For more information on the data tags, see Appendix E.

Direct Words

Direct words are data delivered in a single message. A SynchLink
message can contain a maximum of four direct data words; each word
is 32 bits in length. Direct data can be automatically forwarded to the
next node in the daisy chain configuration.

Multiplier

The Multiplier multiplies one Direct Word on the receive port by the
value in the local tag "Local:x:O.Multiplier" before transmitting it out
the transmit port. This is useful when your application requires fine
adjustments to the direct word between SynchLink nodes.

EXAMPLE If the Direct Word 0 passes process status on and the
local controller in the downstream chassis identifies

a change in the process, you can use the multiplier
to change the value of the direct word before
passing it on to the next processor.

Although you can configure the multiplier for any of the Direct Words,
it can only be used with one Direct Word at a time.

The multiplier can only transmit the same word it received (i.e. this
feature does not allow your module to receive direct word 0 and
transmit it as direct word 1). The multiplier is limited to 16 bits; any
value used in the multipler larger than 65535 is truncated to 16 bits,
and a multiplier overflow error (described below) is reported by the
Synchlink module. Make sure any data that is passed onto the Output
word is less than 65535 else you receive incorrect output data.
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Mutiplier Overflow

The Multiplier Overflow bit is a data tag (Local.x.l.SynchLinkMultiplier
Overflow) that exceeds the maximum multiplier value of 65535. This value is
reported back to you through the input data tags.

If you want to pass a Multiplier Overflow value
(received from an upstream node) to a third node
downstream but not multiple the direct word data
transmitted to the downstream node, you must use a
Multiplier value = 1.

IMPORTANT

The Transmitted Direct Words are configured on the following screen:

Module Properties - Local:1 [1756-5YNCH/A 1.1) E

Transmitted Direct Words

Source:

Transmitted Direct Words >

Cancel < Back Mext > | Finish »> I Help

Publication 1756-UM521A-EN-P - August 2001



3-16  SynchLink Module Features

CST and SynchLink Mastership

The SynchLink module can be configured for multiple mastership and
slave roles in respect to the Coordinated System Time and the
SynchLink. For more information on these roles, see Chapter 2, Time
Synchronization in the ControlLogix System.

Time mastership is configured on the following screen.

Module Properties - Local:3 [1756-SYHCH/A 1.1)

~ iMake this madule the Coordinated | M ird Make this module the Coordinated
HSystemn Time Master for the chassis. System Time Master for the SpnchLink.

DANGER: If this setting is cleared DANGER: If thiz setting is clzared
onling, all active servo axes in any online, all active serva axes in any
controller in the chassis will be chassiz dependent on this

turned off, Coordinated System Time will be
turned off

Cancel ¢ Back I Mext I Finigh > I Help

Chapter Summary and In this chapter, you learned about the ControlLogix SynchLink module
, features. For information about Installing the SynchLink Module, see
What's Next Chapter 4 ey
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Chapter 4

Installing the SynchLink Module

This chapter describes how to install the ControlLogix
SynchLink module.

For information on: See page:
Noting the Power Requirements 4-1
Installing the Module 4-2
Connecting the Fiber Optic Cable 4-3
Removing the Module 4-4
Chapter Summary and What's Next 4-5
Noting the Power This module receives power from the 1756 chassis power supply and

Requirements requires 2 sources of power from the backplane:

» 1200mA at 5.1V dc
* 3mA at 24V dc

Add this current/power value (6.19W) to the requirements of all other
modules in the chassis to prevent overloading the power supply.
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4-2  |Installing the SynchLink Module

|n3ta||ing the Module You can install or remove the module while chassis power is applied.

WARNING When you insert or remove the module while
backplane power is on, an electrical arc can occur.

This could cause an explosion in hazardous location
installations. Be sure that power is removed or the
area is nonhazardous before proceeding.

Repeated electrical arcing causes excessive wear to contacts on both
the module and its mating connector. Worn contacts may create
electrical resistance that can affect module operation.

1. Align the circuit board with the top and bottom chassis guides.

Printed
Circuit
Board

20806-M

2. Slide the module into the chassis until the module locking
tabs ‘click’.

Locking tab

20807-M

Publication 1756-UM521A-EN-P - August 2001



Installing the SynchLink Module ~ 4-3

Connecting the Fiber Your 1756-SYNCH module has two ports for fiber optic cables. The
. front port is used to receive data, and the rear port is used to transmit
Optic Cable data.

1. Remove the plugs from the ports at the bottom of the module.

Keep the plugs that were removed to connect the
TIP ) . .
fiber optic cables. When the cables are disconnected,
> you can reinsert the plugs into the ports to protect
them.

2. Connect the fiber optic cables as shown below.
Figure 4.1

31267

ATTENTION Do not Ic_)ok directly into the fiber ports or fibe_r
cables. Light levels may cause damage to eyesight.

The SynchLink module is a Class 1 LED product.
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4-4  |Installing the SynchLink Module

Removing the Module

Publication 1756-UM521A-EN-P - August 2001

Table 4.A lists the possible connections that might be made to your
1756-SYNCH module and where to connect the fiber optic cable.

Table 4.A

Making Fiber Optic Cable Connections to the 1756-SYNCH Module

If your 1756-SYNCH
module is configured to:

Make this fiber optic cable connection:

transmit data only

Connect the fiber optic cable to the rear port. The other end
of the cable should be connected to a device receiving data
over the SynchLink from your 1756-SYNCH module.

receive data only

Connect the fiber optic cable to the front port. The other end
of the cable should be connected to a device transmitting
data to your 1756-SYNCH module over the SynchLink.

transmit and receive data

1. Connect the fiber optic cable going to (i.e. transmitting
the data to) a module receiving the data to the front port.

2. Connect the fiber optic cable coming from (i.e. receiving
the data from) a module transmitting data to the rear port.

This completes installation. Use the next section to remove your
SynchLink module if necessary.

ATTENTION Before you remove the module, you must disconnect

the fiber optic cables.

A

1. Pull the fiber optic cable out of the connection port.

TIP If you kept the plugs that were removed to
connect the fiber optic cables, reinsert them to

> protect the ports.



Installing the SynchLink Module ~ 4-5

2. Push in the top and bottom locking tabs.

3. Pull the module out of the chassis as shown.
Figure 4.2

Locking tabs

20808-M

Chapter Summary and In this chapter, you learned how to install the ControlLogix SynchLink
) module. For information about Configuring the SynchLink Module,
What's Next see Chapter 5.
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4-6 Installing the SynchLink Module

Notes:

Publication 1756-UM521A-EN-P - August 2001



Chapter 5

Configuring the SynchLink Module

This chapter describes how to configure the ControlLogix SynchLink
module using RSLogix 5000 programming software.

For information on: See page:
Overview of the Configuration Process 5-2
Choose a SynchLink Configuration 5-3
Chapter Summary and What's Next 5-10

You must configure your module upon installation. The module will
not work until it has been configured.

This chapter offers a configuration overview and the three available
ControlLogix SynchLink configurations. For specific examples of each
configuration, see the following:

« Star Configuration - Appendix B - This example shows a
configuration using Remote Axis Data.

 Daisy Chain Configuration - Appendix C

» Ring Configuration - Appendix D

RSLogix 5000 Configuration Software

Use RSLogix 5000 to write configuration for your SynchLink module.
You must write configuration for each module because module
position in the SynchLink system affects configuration. For example, if
a SynchLink module is the Time Master for the system, it must be
configured as such.
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5-2  Configuring the SynchLink Module

Overview of the Figure 5.1 shows an overview of the configuration process:

Configuration Process Figure 5.1

1. Choose a SynchLink configuration.

Star Configuration Daisy Chain Configuration Ring Configuration

THORGRGR SRORGRGR

'

2. Create a new
RSLogix 5000
project.

f

3. Adda
Steps 2 - 5 must be SynchLink
taken for every module to
SynchLink module the RSLogix
(and its respective 5000 project
chassis) in the N
chosen SynchLink +
configuration. 4. Use the -
These configuration W|za_rd °
changes occur conflgu_re the
before module ?g:jclnlémk
operation begins. '

5. Go online to download new
configuration to the module.

Steps 6 - 7 should l'
only be taken as 6. Change configuration (via
necessary for each RSLogix 5000) as necessary,
module. l
These configuration 7. Send new configuration (via
changes occur after RSLogix 5000) to the moduld.
module operation 12986
has begun. e
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Configuring the SynchLink Module ~ 5-3

Choose a SynchLink You must use one of the following SynchLink configurations:
Configuration

Star Configuration - See Appendix B for an example.

ControlNet e
| B
SynchLink | u |
l : Hub :
; || |
_ ’V n | * + _ \ |
ﬁﬁ”” Hub Hub {(m”“
: Y Y N § Y Y 7\
| ((ﬂ L ((ﬂ L
42747 e
Daisy Chain Configuration - See Appendix C for an example.
[\ ) (&) @ 8\ (e &) (@
‘ g g °| 8 EEB = o 8 a@°| g EE‘_‘ °| g 8] 8[°c| g uﬁé | o 8] a@f°c| g u_x:_-il
i i B L
r wT r A e r A BT r A I
\ T - ‘ Y - Y -
SynchLink ControlNet 42746
Ring Configuration - See Appendix D for an example.
) (@) @) e\ 8\ [8\ (@) (@
. 8 g [} uga | 8 8 & 1 u:-‘_j °| 8 8 8 1 uﬁé g 8 g"° 1 u_x:_-it
o B o o
ST ST =T =T

Y
Y
Y

SynchLink ControlNet e
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5-4  Configuring the SynchLink Module

Create a New RSLogix 5000 Project
1. Use the File menu to create a new project.

‘0, RSLogix 5000

B3 £t View Seach Logc Cor

Choose a New project ————— I ENCTIN

Open... Cul+0 |

from the File menu. s r

Seve il
o s

New Component »

[Eoasy

Bt iR
Print Options.

1C5T_Time_Master ACD
2 Syneh_Link ACD

Esit
e

2. Name the controller.

Wendor, Allen-Bradley
A. This controller is a 1756-L1. Bpe—Bi75611  Contolog5S0Conoler v| | Ok E. Click here to use the
™ Redundancy Ensbled Cancel new controller.

B. This controller is named Moo po{Tire_Master_chassic Help

Time_Master_chassis. D =

LI

C. This controller is used in a Shossie Fypom{1 75647 7610l ContoLogi Chasso 7]

7-slot chassis. /sn.ﬂ Redionr [ F =
D. The controller slot number Ciestalne | \FSLogix 5000 Frojects Brawsa

is 0.
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Configuring the SynchLink Module ~ 5-5

A. Select I/0 Configuration.

B. Click on the right mouse button
to display the menu.

C. Select New Module

A. Select a 1756-SYNCH module———»

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces
IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

=3 Controller SynchLink
L@ Contioller Tags

-3 Controller Fault Handier

[ PawerLp Handler

B3 Tasks

E-48 MainTask

- BB MainProgiam

i B Program Tags

MainFoutine

L.[73 Unscheduled Programs

[ Trends

£ Data Types

.0, UserDefined

£ Stings

P STRING

L, Predefined

: le-Defined

[Euit
[Eopy
Easte

{ige

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

b ajor B evision:

Link Bridge

1 ~] <—— Make sure the
Major Revision |
number matches =

Type | Drescription

1756-0C8 8 Paint 300-600 DC Output

170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay
1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

— Shuo
Wendor: IAII

j ¥ Other W Specialty 140 Select Al |

¥ &nalog W Digtal W Communication W Motion [V Processor

Clear All |

Cancel | Help |

B. Click here
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5-6  Configuring the SynchLink Module

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Type: 1756-57MCH /A SynchLink Interface
Wendar: Allen-Bradley
Parent: Local
A. MOdU|e name is —  p-Mame ITime_Master Slat: |3 j<— D. Module slot
Time_Master. Desciglion: = number is 3.
=
B. Receive Port Comm Format is Reseive Pat Earer-Ferraief N0 Fieccive D atz =l
No Receive Data. 1 A, 3 Direct Words, 14 Buffered =]

Electronic Keying: ICDmpatibIe Module 'F E. Electronic Keymg

C. Transmit Port Comm Format is method is
1 Axis, 3 Direct Words, Corcsl | bt | Mews [[ Fmsh» | e Compatible Module.
14 Buffered. '

F. Minor Revision = 1. G. Click here after
completing the
information on this page.

Requested Packet Interval = 20mS Requested PacketteraHBRp—  20.0=ms (20 750.0ms)

™ Inkibit Madule
™ Major Fault On Contraller IF Connectian Fails 'While in Fun Mods
tadule Fault
Cancel | < Back | Nest » | Finish >3 I Help
Click here to move to the next page
Module Properties - Local:3 [1796-SYNMCH/A 1.1)
— SynchLink Transmitted Axes:
Az 0 | Application_fwis_& j J
Mew bxis...
Use the pull-down menu, to choose 7T B— =] J &I
which axis data tags to transmit {nene

over each axis.

Cancel | <Back | MNgu» |[ Finsho> | Heb

Click here to move to the next page
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Configuring the SynchLink Module

5-7

@

The Module Identification page is
blank during initial configuration.

@

Module Properties - Local:1 [1756-SYMCH/A 1.1)

~ Identification Statu
“endor: b sjor Fault:
Product Type: tinar Fault:
Product Code: Internal State:
Revision:
Serial Number, Corfigured:
Product M ame: Owned:

todule |dentity:

—Coordinated Spstem Time [CST)]———————————
Tirner Hardware:
Timer Sync'ed Fiefiest | Fieset Mudulel

Cancel | < Back I Mexst > I Finizh »> | Help |
Click here to move to the next page
Module Properties - Local:1 [1756-SYNCH/A 1.1) [ x|

~ Transmitted Direct Words
Source:

Use the pull-down menus to choose
which direct words are transmitted.

The example module is configured
as the Time Master for:

« the chassis - optional

« the SynchLink - required
IMPORTANT: In this configuration,
the SynchLink module must be the
Time Master of the SynchLink, but it
is not required to be the Time Master
of the chassis. If the module is not
the Time Master of the chassis, it
receives the CST timer value from the
chassis backplane.
For more information on Time
Mastership, see Chapter 2.

Cancel |

<Back | Mewi |[ Fmehs> | Hep

N\

Click here to move to the next page

Module Properties - Local:3 [1796-5YNCH/A 1.1)

ke thiz module the Coordinate
shern Time Master for the chas

DAMGER: If this setting is cleared
online, all active serva axes in any
caontroller in the chassis wil be
turned off

Make this module the Coordinated

//F System Time Master for the SpnchLink.

DAMNGER: If this setting is cleared
online, all active servo akes in any
chassiz dependent on this

Coordinated System Time will be
turned off.

Cancel |

< Back I Mext » I Finigh > I Help

Click here to finish configuration.
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5-8  Configuring the SynchLink Module

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

|
Ea Path: |4B_ETH-14130.1%
A. Click on the triangle to i

see the pull-down menu. f||| ddEee

Select Recent Path...

Go Onling

B. Click on Download.

I Brogram ade:
| Ftum ade
H Testiode

Lock Eartraler

[Elear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3
Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data Cancel |

This completes the download process.
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Configuring the SynchLink Module ~ 5-9

Changing Configuration
After Module Operation
Has Begun

A. Click on the triangle to see

the pull-down menu.
B. Click on Go Offline.

A. Right-click on the module
to see the pull-down menu.

B. Click on Properties.

You change configuration for your SynchLink module after operation
has begun, but you must go offline first. Follow these steps to change
the SynchLink module configuration:

1. Go offline.

“s RSLogix 5000 - User_doc [17]
File Edit “iew Search Logic [

In rcte Brogiam >v| INnFnr:es

I \S'—\f:'n A;“VE . ces Dig
I Select Recent Path.. 1644
Go Offline i
W plead
Donlead] ndle
Erogranmidede
Bun Mode
Test Mode
Lock Contraller a0s
B
[Elear Faulis ramd
By e F=ih
=3 Data Types

2. Access the module properties in RSLogix 5000.

! %o RSLogix 5000 - Synch_Link [1756-L1

| File Edit Wiew Search Logic Communic

Path: I {none

Offline 0. T RUN E
Mo Forces b :: gAKT
Mo Edits = il

E1-E5] Controller Synch_Link
Controller Tags
-3 Cortroller Fault Handler
| .23 Power-Up Handler
L e Tasks
| E% MainT ask
Ea b4 ainProgram
; Program Tags
Exj tainF outine:
L[ Unscheduled Pragiams
(3 Trends
E-E5 Data Types
Cﬂ User-Defined
= Eﬂ Strings
. L@ sTRING
Cﬂ Predefined
- Module-Defined
EIS 1/0 Canfiguration

2 fErhodule..

(B0t

4
] O

Edit properties for selecte Faste
Delete

Cross Reference

Fiifit
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5-10  Configuring the SynchLink Module

3. Make the necessary changes.

A. In this example, the
Connection tab was
accessed to change the RPI.

[ Module Properties - Local:3 (1796-SYMCH/A 1.1) E
SynchLink Configuration | Time Mastership I Backplane I
General Cannection” | Associated Axes | Module Info
REEster Paketntervat iR 20 ms (02 7500 s
™ Inhihit Module

™ Major Faulk On Controller If Connection Fails ‘fhile in Aun Mode

Module Fault

EI0ER e akK I Cancel Apply Help

B. Click on OK to
make the changes..

Chapter Summary and
What's Next
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In this chapter, you learned about the general configuration
process. For specific configuration examples, see:

» Appendix B - Star Configuration with Remote Axis Data
» Appendix C - Daisy Chain Configuration
» Appendix D - Ring Configuration

For information on Troubleshooting the SynchLink Module, see
Chapter 6.



Chapter 6

Using the Status Indicators

Troubleshooting the SynchLink Module

This chapter describes how to troubleshoot the ControlLogix

SynchLink module.

For information on: See page:
Using the Status Indicators 6-1
Using RSLogix 5000 to Troubleshoot the 6-3
Module

Chapter Summary and What's Next 6-11

The SynchLink module uses status indicators to show SynchLink and
communications status (red/green) and a bi-colored LED for module

"OK" (red/green).

SynchLink
LINK LINK
COMM SYNC

C ok

42875

During power up, an indicator test is done and the following occurs:

* The "OK" indicator turns red for 1 second and then turns to
flashing green if it has passed the self-test.
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6-2  Troubleshooting the SynchLink Module

Use Table 6.A to troubleshoot your module.

Table 6.A
Troubleshooting the 1756-SYNCH Module
LED This Means: Take this action:
indicators: | display:
COMM Steady green | The module is configured and None
light operating properly.
COMM Off 1. The module is not powered. | 1. Power the module.

2. The module is not configured. | 2. Configure the module.

3. The module is configured to | 3. Check fiber connections and
receive data from SynchLink diagnostic counter for errors.
but did not receive it in the If the problem persists,
last scan. replace the cable or module.

4. The module is configured to | 4. Make sure configuration is
transmit on SynchLink but complete and downloaded. If
has not enabled its the problem persists, replace
transmitter. the module.

5. The Transmit and Receive 5. In RSLogix 5000, make sure
communications formats do communications formats
not match between linked match between linked
modules. modules.

SYNC Steady green | The module is the Time Master | None
light or a time relay and

synchronization is complete.

SYNC Flashing 1. The moduleis configuredasa | 1. Establish a CST master on the
green light time relay from chassis backplane.

backplane to SynchLink but is
not synchronized with a CST
master on the backplane.

2. The module is configured as a
time relay from SynchLink to
chassis backplane but has
not synchronized with the
upstream device.

2. Check configuration and
make sure all modules in the
system are properly
connected and online.
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Troubleshooting the SynchLink Module ~ 6-3

Using RSLogix 5000 to

Table 6.A
Troubleshooting the 1756-SYNCH Module
LED This Means: Take this action:
indicators: | display:
SYNC Flashing red | 1. The module is configured as | 1. Check configuration
light the CST Time Master and has throughout the system and
detected another CST Time verify there is only one CST
Master. Time Master.

2. The configuration information | 2. Check configuration of this
received from SynchLink does module and all upstream
not match the module’s SynchLink devices.
configuration.

3. The module is configured as | 3. Check configuration for all
Time Master on SynchLink modules in the system to
and has received time make sure only one is the
information from another SynchLink Time Master.
Time Master on SynchLink.

SYNC Off 1. The module is not powered. | 1. Power the module.
2. The module is not configured | 2. Configure the module for its
as Time Master or time relay. proper function.
OK Steady green | The module is operating None
light properly.
oK Flashing The module is powered and Configure the module.
green light ready for operation but has not
received configuration.
OK Steady red The module has experienced an | Replace the module.
light unrecoverable error.
0K Flashing red | A flash upgrade is in process. Wait for upgrade to finish. New
light application code may be needed
afterward.
OK Off The module is not powered. Power the module, if needed.

Troubleshoot the Module

In addition to the LED display on the module, RSLogix 5000 alerts you
to fault conditions. You are alerted in the following ways:

» Warning signal on the main screen next to the module-This
occurs when the connection to the module is broken

* Notification in the Tag Editor - General module faults are also
reported in the Tag Editor.

« Status on the Module Info Page
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Troubleshooting the SynchLink Module

The screens below display fault notification in RSLogix 5000.

Warning signal on main screen

s, RSLogix 5000 - SynchLink [1756-L1]
Fle Edt View Seach Loge Commuricaions Tools Window Help

EEREEEENEE R ——
i [

[ [=] E3

[ ot [FECETRANTS0151 36 To0Bsckplanert

Offine: =] o Faces |
Forces Disabled ||

Path” 8B_ETH-11130.151.136.164\Backplane\1

[ Contoler Sumchiink
~[# Controller Tags
3 Contraller Fauit Handler
(1 PoverLip Handler
&5 Tasks
48 ManTask
=3 MainProgram
Program Tags
~[E) MainRoutine
(3 Unscheduled Programs -

B

! #0 Configuration

H H £ Trends -
Warning icon when a | (N - Fle) 111758-5YNCH 8 Synch_1
communications fault occurs 68 Shirgs” 1

or if the module is inhibited

[ STRING
(4 Predefined
Oy Module-Defined
ES/0 enfighiation —  ~

Ready

V_Al

Fault message in status line

= Module Properties - Local:1 [1756-5YNCH/A 1.1]
SynchLink Configuration I Time M astership I
General Connection I Agsociated Ares
. . . ~ ldentification ~ Statu

Status section lists Major and Allen-Bradiey Msjor Famt None
Mlnor Faults and the |nterna| Product Type: Specialty 1/0 inor Fault None

Product Cade: 1756-SYNCH Irttermal State: Unconnected
State of the module .

Revision: 11

Serial Mumber FFFFFFFF Configured Yes

Froduct Mame: 1756-SYNCH Ver. 1.0 Owned: No

Madule Identity: Match
i~ Coordinated System Time (CST)

Timer Hardware: Ok

Timer Sync'ed Yes Refresh J Reset Modulej
Status line provides information on Status: Faulted ok | ceneel | sl | Hen |

the connection to the module

Notification in Tag Editor

Scepe: [Synch Linkicontole = Show [Show A1 =l se: [TagName =]
Tag Name 7 [Valus «|FoceMask <[ Sule Ty~
=l LocalT:l (.} ) A
|+|-Local1:1.Fault Z#0000_000. .. Binary on
I Local1:| ChassisMuliM aster i Decimal BC
A value of 1 shows a fault for this P —tora e Tt -1 Diocimal BC
: : | Lacal 1:1.SynchLinkRxFault 0 Decimal BC
InPUt pOInt X ) —Local1:1.SynchLinkD ataFault a Decimal BC
IMPORTANT: If all input fault bits are Locak1:1 SynchLinkFormatF aul o Decimal BC
| Lacal 11 SynchLinkMultiMaster i Denimal BC
set to 1, the controller cannot connect | Lacal1:1.SynchLinkCS TFaul 0 Decimal BC
to the module. In this case, the use the Locak 1:1.SynchLink S TUnsprch 0 Decimal BC—
. . . I Lacal1:1 SyrchLinkMultiplierDverow i Decimal BC
Connection tab in the RSLogix 5000 Lol PPt o Decina bt
properties wizard (See page 6.5) to - Local 1:1.Rxtwis] Fault 0 Drecimal EC
. —Local1:1.AxisOMoConsurner a Decimal BC
determine the problem. Also, the i vt o Decimal o
i i | Local 1:1. TubwisOF ault i Denimal BC ~
RSLogix 5000 online help offers a (515 ]\ Mortor Tage 0 _'l_l

definition of all fault bits.
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Troubleshooting the SynchLink Module ~ 6-5

The fault type is listed here

In this example, Error 1640011
means Counter 0 was set to an
invalid Operational Mode

Determining Fault Type

When you are monitoring a module’s configuration properties in
RSLogix 5000 and receive a Communications fault message, the
Connection page lists the type of fault.

B Module Properties - Local:5 [1756-HSC 1.1) '

General Connection | Madule Inlol Backplane |

Benuested Packet Interval [RPI): I 2 DE: mz [20 - 750.0 ms)
1
™ Major Fault 0n Controller |f Connection Fails While in Bun Mode

— Module Fault
[Code 164#0003) Module Configuration Rejected: Parameter Emar.

Additional Fault Code T6H0011

Status: Faulted QK I Cancel Ll Help

For a detailed listing of the possible faults, their causes and suggested
solutions, see Module Table Faults in the online help.
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6-6  Troubleshooting the SynchLink Module

Using Diagnostic Counters

The 1756-SYNCH module uses diagnostic counters; the counters
contain additional information about the module. See Table 6.B for
more information on the SynchLink module diagnostic counters. This
information must be used in the Destination field of the Configuration
pop-up screen (page 6-9).

For more information on how to access the diagnostic counter
information, see page 6-7.

Table 6.B

SynchLink Module Diagnostic Counters

Name: Description:

Data Type

Attribute ID:

Possible Values:

Status Status of this device on the
SynchLink system

DINT

1

This counter lists the status of the following bits (0 = bit is
not faulted, 1 = bit is faulted):

Bit 0 - Reserved (default =0)

Bit 1 - Reserved (default =0)

Bit 2 - Receive fault. No data has been received from
the upstream device.

Bit 3 - Data Fault. The upstream device is in the idle
state.

Bit 4 - Data Comm Format Mismatch Fault. The
communications format of data received from the
upstream device does not match this device’s receive
port communications format.

Bit 5 — Duplicate SynchLink Time Master Fault — This
device is configured to be SynchLink Time Master but
has received a CST update from another Time Master
Bit 6 — CST Drifting — CST synchronization with
SynchLink was not verified at last beacon but was
verified within last 6 beacon updates

Bit 7 — CST Synchronization Fault — The device CST is
not synchronized with SynchLink.

Bit 8 — Multiplier Overflow Fault — The output of the
multiplier exceeded 16 bits

Bit 9 — Axis 0 Receive Fault — The device is
configured to receive Axis 0, but Axis 0 was not
received from the SynchLink system.

Bit 10 — Axis 1 Receive Fault — The device is
configured to receive Axis 1, but Axis 1 was not
received from the SynchLink system.

Bit 11 — Axis 0 Unclaimed Fault — Axis 0 was
received from the SynchLink system but was not
consumed by the local controller.

Bit 12 - Axis 1 Unclaimed Fault — Axis 1 was received
from the SynchLink system but was not consumed by
the local controller.

Bit 13 — Axis 0 Transmit Fault — The device is
configured to transmit Axis 0, but Axis 0 was not
produced by the local controller.

Bit 14 — Axis 1 Transmit Fault — The device is
configured to transmit Axis 1, but Axis 1 was not
produced by the local controller.

Bit 15 — SynchLink Revision Fault — The SynchLink
revision was received but the data

is not compatible with the receiving module’s
revision.

Bits 16 to 31 — Unused (Default = 0)

CRC Error Number of CRC errors detected | DINT

Counter on the SynchLink system since
power-up or last reset service

0t02%2-1
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Troubleshooting the SynchLink Module

Table 6.B
SynchLink Module Diagnostic Counters
Name: Description: Data Type Attribute ID: | Possible Values:
Framing Error | Number of framing errors DINT 3 0t02%2.1
Counter detected on SynchLink since
powerup or last reset service
Incomplete Number of incomplete package | DINT 4 0t0232-1
Package Error | errors detected on SynchLink
Counter since powerup or last reset
service
SynchLink Revision of SynchLink supported | DINT 5 Bits 0 to 15 - Minor Revision
Revision Bits 16 to 31 - Major Revision

Message Instructions

To retrieve and reset the SynchLink diagnostic counter information,

you must use a message instruction in ladder logic and a CIP message.
This ladder logic is written in the Main Routine section of
RSLogix 5000.

Double-click here to

‘s, RSLogix 5000 - Synch_Link [

File Edit View Search Logic

|| Offline 0. 7 AUN
NoForcss  b|— OK
Mo Edits = ,E‘Eg

enter the Main Routine

After adding a message
instruction to a rung, you
must create a tag for the
message instruction

1Right-click on the
question mark (?) to see
this pull-down menu.

2 Click here to Create a

New Tag.

F-=5 Contraller Synch_Link

% RSLogix 5000 - Synch_Link [1756-L1] - [MainProgram - MainFoutine”]

B File Edt View Sesch Logic Communicstons Iooks Window Help R
‘pa.h|<nw> jJ“@ﬁﬂ@] @] |
| Offline 0, FRUN |
MoForces b, ”:SAKT ‘w
NoEds A I L= = T 7 R T | ol
ll _«| »|\Favorites BT £ ThmerCourter A npuliouel A Compare

-1 Contioller Spnch_Link.
i-[@ Controller Tags

Controller Faul Handler
(3 PowerUp Handier
b3 Tasks
- MainT ask
i EEB MainProgiam
: @ Program Tags
i .. MainRioutine
(3 Unscheduled Programs
-3 Trends
b3 Data Types
g UserDefined
-] S
HEge:
wig
-, Module Defined

b3 1/0 Configuration
Bl [11756-5YNCH/A SYNC]

Predefined

ly | 31

A [P B
0 e Message |—<£
e Message Corirol [PS— T nr
: L
. —_ . |
e Cut Instuction Chilix
Copy Instriction CikC
[End) Favte Chf
Delete Instruction Del
Add Ladder Element Ins
Edit Instruction Enter
Edit bizin Dperand Description. Cii+D
Fiemave Foree
GoTa G
[{] ]\ MainRoutine” / 4 | 3]
Rumg 0of 1 [2PP VER 7
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6-8  Troubleshooting the SynchLink Module

Name the tag here.

Enter an optional description here.

Choose the Base Tag Type here.

Choose the Message Data Type here.

Choose the Controller Scope here.

IMPORTANT: Message tags can only
be created with the Controller Scope.

Fill in the following information when the New Tag pop-up
screen appears:

IMPORTANT We suggest you name the tag to |nd!cate_ what _
module service the message instruction is sending.

For example, the message instruction below is used
to retrieve diagnostic counters, and the tag is named
to reflect this.

4"_\‘65'61—."}4atrieve_Diagnost\c_Counters
—————DBescription: ot d Cancel |
j Help |
——FagFepe— Bace
 plias
" Poduced |2 —‘Icnnsumers
]
" Conzumed
A@DE—DIMESSAGE _I Configure: |
%ggpg-—.iSynch_Link[conlroller] ﬂ
Style: I ﬂ

Message Configuration

After creating a new tag, you must enter message configuration.

1] Tupe - Unconfigured
b Eaontial

Click here to see the message
configuration pop-up screens

Publication 1756-UM521A-EN-P - August 2001




Troubleshooting the SynchLink Module ~ 6-9

Service Code is 1
Class Name is 31B
Instance Name is 1

Enter message configuration on the following screens:

 Configuration Pop-Up Screen
» Communication Pop-Up Screen

A description of the purpose and set-up of each screen follows.
Configuration Pop-Up Screen

This pop-up screen provides information on what module service to
perform and where to perform it. For example, you must use this
screen to retrieve diagnostic counters (module service) from the
1756-SYNCH module (where to perform service).

Message Configuration - Retrieve_Diagnostic_Counter

Configuration® I Communicat\om' Tag |

Message Type is CIP Generic  ————~—thessageFype—BCIP Generic =l
——Gewicefode—— 1 Hed  Soure: - = There is no Source.
= 318 (Hel  Mum Of Elements:[1 <€ -Bytes] Number of Elements is 0
————tmtacereme——f1 Destination [Fietne @bisgroste_Ea v Destination is a tag of
—;&&nbgmmc‘—.’ﬂ— [Hex) New Tag... | type DINT [5]

Attribute name is 0

IMPORTANT: The
data containted in
this DINT is described
in Table 6.B.

3 Enable 2 Enable aiting b Start 2 Done Dione Length: 0
2 Ertor Code: I Timed Out &

Extended Emar Code:

oK I Cancel Apply Help
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6-10  Troubleshooting the SynchLink Module

1. Choose the module
that is to receive
the message
instruction.

Publication 1756-UM521A-EN-P - August 2001

Communication Pop-Up Screen

This pop-up screen provides information on the path of the message
instruction. For example, the slot number of a 1756-SYNCH module
distinguishes exactly which module a message is designated for.

Use the Browse button to see a list of the I/0
modules in the system. You choose a path when you
choose a module from the list.

IMPORTANT

You must name an I/0O module during initial module
configuration to choose a path for your message

Instruction.
Message Configuration - Retrieve
Configuration  Communication® | Tan |
Path: ITime_Masler i Browse ‘]- Use this Browse
T esten button to see a
Cammmurieationethed |ISt SUCh as the
G CIpE Chanmel I j' [estinatior Link: 3: one dISpIayed
IRt ; 3‘ ot . 3
(ol oD Source ik - [estnatie Hade: =l | [[eta] beIOW.
" Connected W | Gache Copnections. &
2 Ensble () Enable Watting ) Start ) Done Done Length: 0
‘2 Ermor Code: Extended Error Code: ™ Timed Out €
Error Path:
Error Text
oK Cancel | Apply | Help

Path; [Time_Master

Time_Master

-4 140 Canfiguration
Lo SR 1] 1755-5YHCH /A Time_Master
8 13117565 YNCH 4, SpnchLink,

0K | Concel Helps

4. Click on OK.
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Retrieving and Resetting You can use the diagnostic counters to recognize a problem with your
1756-SYNCH module. After correcting a problem, though, you may

DlagI']OStIC Counters want to reset the counters for future use. The counters are also reset
via message instructions and a CIP message.
1. Create a message instruction, as described on page 6-7.
2. Use the values listed in on the Configuration Pop-Up Screen to
retrieve or reset the counters.
Table 6.C
Configuration Pop-Up Screen Values Required to Reset SynchLink Module
Diagnostic Counters
Field: Value to Retrieve the Value to Reset the
Counter: Counter:
Message Type CIP Generic CIP Generic
Service Code 5 5
Class 31B 31B
Instance 1 1
Attribute 0 0
Source NA NA
Source Length 0 0
Destination Retrieve Diagnostic NA
Counters
Chapter Summary and In this chapter, you learned how to troubleshoot the ControlLogix
) SynchLink module. For information on the module specifications, see
What's Next Appendix A.
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Notes:
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Appendix A

Specifications

General Specifications

Module Location 1756 ControlLogix chassis
Backplane Current 1200mA @ 5.1V dc & 3mA @ 24V dc
Maximum Power Dissipation 6.19W

Thermal Dissipation 21.1 BTU/hr

Connecting Cable

Fiber Type 200/230 micron Hard Clad Silica (HCS),
Fiber Termination Type Versalink V-System
Assemblies Order assemblies from Rockwell Automation under

catalog 1403-CFxxx (xxx=length in meters) or from
Lucent Technologies Specialty Fiber Technologies

Division

Maximum Length 300m
Minimum Length im
Operating Wavelength 650nm (red)
SynchLink Data Rate 5Mbps
Baud Rate 5Mbaud
Type of Communication Synchronous

Frame Parameters

3 Flags - 3 bytes
Control field - 1 byte
Data field - 24 bytes
CRC field - 2 bytes

Frame Period

50us

Indicators

Green and red indicators for operation,
status and diagnostics

Environmental Conditions
Operating Temperature
Storage Temperature
Relative Humidity

Shock Operating
Non-operating

Vibration

0 to 60°C (32 to 140°F)

-40 t0 85°C (-40 to 185°F)

5 to 95% noncondensing

30g peak acceleration, 11(+ 1ms) pulse width
509 peak acceleration, 11(+ 1ms) pulse width
Tested 29 @ 10-500Hz per IEC 68-2-6

Agency Certification
(when product or
packaging is marked)

'IjL_. Listed Industrial Control Equipment

@@ Certified Process Control Equipment
Certified Class I, Division 2, Group A, B, C, D

c E Marked for all applicable directives

0 Marked for all applicable acts
N223
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Notes:
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Appendix B

Configuring the Star Configuration

This appendix describes how to configure the ControlLogix SynchLink
module in a Star configuration using remote axis control. In this
example configuration, the following occurs:

» The controller in the Time Master chassis produces axis data.

» The axis data is transmitted via SynchLink modules to each Time
Slave chassis.

» The controller in each Time Slave chassis consumes the axis
data.

The system’s physical configuration is shown in Figure B.1. In this
configuration, you must:

 configure the Master Node in an RSLogix 5000 project.
» configure each End Node in separate RSLogix 5000 projects.

Figure B.1

The SynchLmk module in

ControlNet
¢ as the Time Master for
the SynchLink.
SynchLink —»v
Hub
@ Y 8 [ Y 8\
el o wee] o de. PN HEEE
TEEnd Node == T End Node
'HH 'rHHu

N / -

The SynchLink modules in these chassis are configured as
the CST Time Masters and SynchLink Time Slaves.
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B-2  Configuring the Star Configuration

Using Remote Axis Control Most applications using the ControlLogix SynchLink module use it for
Remote Axis Control. You can use the SynchLink module to produce
axes from a master chassis and broadcast the data to other chassis.

Slave chassis consume the broadcast axis data and redistribute it to
their local motion planners (i.e. the Logix controller in their local
chassis). With this configuration, you can control multiple axes
synchronously throughout the system.

IMPORTANT This example assumes you have alrgady set_—up axis
data tags for the data the controller in the Time

Master chassis produces; this manual does not intend
to explain how to plan the motion portion of your
application as that is a controller function.

If you do not know how to set-up remote axis data
tags and account for them in the motion portion of
your application, see the ControlLogix Motion
Module Setup & Configuration User Manual,
publication 1756-6.5.16.

Time Master Chassis Configure Time Master Chassis - Master Node

You must complete the following tasks to configure the time
master chassis.

SynchLink

» Create a New RSLogix 5000 Project

» Add a SynchLink Module

 Configure the SynchLink Module
— Name the module
— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option
— Set the RPI

— Determine if the module is the CST Time Master for
the chassis

— Make the module the Time Master for the SynchLink
» Download Configuration
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Choose a New project
from the File menu.

A. This controller is a 1756-L1.

B. This controller is named
Time_Master_chassis.

C. This controller is used in a
7-slot chassis.

D. The controller slot number
is 0.

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

‘0, RSLogix 5000

B3 £t View Seach Logc Cor

— T

Open... ikl b
i

Seve il
o s

New Component »

[Eoasy

Bt iR
Print Options.

1C5T_Time_Master ACD
2 Syneh_Link ACD

Esit
e

2. Name the controller.

New Controllst =]
Vendor AllerBradiey
=|' 1756:L1 ControlLogis 5550 Cortoler = | [il3 j—
I™ Redundancy Ersblsd Cancel
o o Time:_Master_chassis Help

Deseription:

=N k|

o —|1755-A7 7-Slot ControlLogix Chassis

C|

LI

/ﬂgiﬂ Revision: |7 |7 _|::'
Cieate e |C¥RSLogik 5000%Projects Browse.

E. Click here to use the
new controller.
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Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces

IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

E

E

A. Select I/0 Configuration.
B. Click on the right mouse button
to display the menu.

C. Select New Module

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

A. Select a 1756-SYNCH module———»

Controller T

E1-48 MainTask

- EHER MairProgram
i Pragram Tags
MainFoutine

L[ Unscheduled Programs

[ Trends

755 Data Types

-4 Controller Synchlink

ags

(2 Controller Fault Handler
(23 PowerUp Handler
55 Tasks

i[O, UserDefined

£ Stings

P STRIN
L, Predefined
: le-Del

G

fined

[Euit
[Eopy

Easte

{ige

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay

1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

Link Bridge

-
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— Shuo
Yendor: IAII j IV Other [ Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear &ll |
QK I Cancel | Help |
%
B. Click here
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Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Propeirties - Local:1 [1756-5YMCH/A 1.1)

Type:
Wendor.
Parent:
A. Module name is ———»-Name:
Ti me_M aster. Description:

B. Receive Port Comm Format is ————FReceivePort EommFoma] Mo Fieceive Data

No Receive Data because the
module is the master of a Star
and does not receive data.

C. Transmit Port Comm Format is
2 Axis.

Requested Packet Interval = 20mS

Use the pull-down menu, to choose
which axis data tags to transmit over
each axis. This menu lists the Axis
tags currently defined in the project.
Use this button to define a new
Axis tag.

IMPORTANT: All produced tags
must be checked as produced tags in
the Tag Editor. For more information
on accessing data tags, see
Appendix E.

Transmit Part Comm Farn

1756-5YNCHA% SynchLink Interface

Allen-Bradley

Local

[Time_Master St [ = «——————— D. Module slot number
Master Chassis Transmits 2 Axes of;l is 3 as shown in the
B P oo o graphic on page B-1.

]
[

2 bz

= Electroric Keying: [Compaiile Modue  ~}&——— E. Electronic Keying

method is Compatible

Cancel | < Bt | Next > | Finish > I Help MOdUIe.

A

F. Minor Revision = 1. G. Click here after

Module Properties - Local:2 [1796-5YNCH/A 1.1) [x]

=1 ted P

completing the
information on this page.

™ Inkibit Madule

™ Major Fault On Controller If Connection Fails Whils in Fur Mods

Module Fault

ketrteraHRRH: E 20.033 ms  [20- 7500 ms]

Cancel | ¢ Back | Mest » | Finigh I Help

Module Properties - Local:3 [1756-5YNCH/A 1.1)

— SynchLink Transmitted Axes:

Click here to move to the next page

Awiz 0: | Application_Asxis_A ﬂ J

fie sl

e buis...

<nones
4

Cancel | < Back | Nest » | Finish > I Help

Click here to move to the next page
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S

The Module Identification page is
blank during initial configuration.

S

Module Properties - Local:1 [1756-SYMCH/A 1.1)

|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:

todule |dentity:

— Coordinated System Time [CST)
Tirner Hardware:

Timer Sync'ed Fefrest | Heset Mndulel
Cancel | < Back I Mext > I Finizh > | Help |

Click here to move to the next page

Module Properties - Local:3 [1756-SYHCH/A 1.1)

— Tranzmitted Direct Words———————
Source:

The module does not transmit any
direct words because the
Communications Format only calls
for Axis data.

The module is configured as the Time
Master for;

« the chassis - optional

« the SynchLink - required
IMPORTANT: In this configuration,
the SynchLink module must be the
Time Master of the SynchLink, but it
is not required to be the Time Master
of the chassis. If the module is not
the Time Master of the chassis, it
receives the CST timer value from the
chassis backplane.
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S A =
J

neal | [ <Back | neds |

Finsh>> | Help

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

~ iMake this module the Coordinated 7/; Make this module the Coordinated
iSystem Time Master for the chassis: 1+ System Time Master for the SynchLink.

DAMGER: If thiz setting is cleared
onling, all active servo axes in any
caontroller in the chassiz will be
turned off

DANGER: If thiz setting is cleared
online, all active servo axes in any
chassiz dependent on this

Coardinated System Time will be
turned off.

<Back [ MNet> | [ Fmshes | Heb |

A

Cancel |

Click here to finish configuration.
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Download Configuration

Download the configuration data.

* File Edit “iew Search Lc

I u
ﬁ Path: JAB_ETH-1413001%

% RSLogix 5000 - Synchli

A. Click on the triangle to
see the pull-down menu. |

B. Click on Download.

» | |Mo
‘who Active

il qu‘ﬂim: I r
f“ Select Recent Path... :

Go Online
Upload...

Download

Brogram iade:
Eurikede
Testiode

Lock Eartraler

[E{ear Faults

e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Click here to download new data

Download E3

&

Download o the contraller:
Mame: User_doc

Type: 1756-L144 1756-M0/0 LOGI-5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1

Path:

This completes the download process.

Cancel |
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CST Time
Slave Chassis

ControlNet /

SynchLink

Choose a New project
from the File menu.

Configure Time Slave Chassis - End Node

You must complete the following tasks to configure the first time
slave chassis.

» Create a New RSLogix 5000 Project
» Add a SynchLink Module
 Configure the SynchLink Module
— Name the module
— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option
— Set the RPI
— Set the module as the CST Time Master for the chassis
 Create Axis Data Tags
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

Zo. RSLogix 5000
Edt Wiew Seach Logic Com
Clrl+H

& Cok0 |
Oicse
Seve 5
Geve s
New Component 3
Eompac:
Efit il
Fiint Options...
1 C5T _Time_Master ACD
2 Synch._Link ACD
Esit
e

2. Name the controller.

A. The controller is a 1756-L1.

B. The controller is named

Time_Slave_End_Node_1.

C. The controller is used in a
7-slot chassis.

Slat: _:I
D. The controller’s slot location /ﬁg SO0 Frojects

is 0.
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Wendor. Allen-Bradley
{1755 L1 ContolLogix 5550 Contraler 7| T F. Click here to use the
1= Fedundenoy Erreied Coancel new controller.
i B Time_Slave_End_Hode_1 Help

Deserigtion: =l

-]
ShossisFopeB{ 175647 7-5lot Cortrollogis Chassis =l

Browse..
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A. Select I/0 Configuration.

B. Click on the right mouse button
to display the menu.

C. Select New Module

A. Select a 1756-SYNCH module———»

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces
IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

=3 Controller SynchLink
L@ Contioller Tags

-3 Controller Fault Handier

[ PawerLp Handler

B3 Tasks

E-48 MainTask

- BB MainProgiam

B Program Tags

MainFoutine

L.[73 Unscheduled Programs

[ Trends

£ Data Types

.0, UserDefined

£ Stings

P STRING

L, Predefined

: le-Defined

[Euit
[Eopy

Easte

{ige

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

b ajor B evision:

Link Bridge

1 ~] <—— Make sure the
Major Revision |
number matches =

Type | Drescription

1756-0C8 8 Paint 300-600 DC Output

170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay
1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

-

— Shuo
Wendor: IAII

j ¥ Other W Specialty 140 Select Al |

¥ &nalog W Digtal W Communication W Motion [V Processor

Clear All |

Cancel | Help |

B. Click here
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Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1756-SYNCH/A 1.1)
Type: 175E-5MCH /4 Synchlink Interface
Wendor: Allen-Bradey
Farent: Local
A. Module name is —————sHame: [Syrohlink Module_Slave sgt[3 =] <=———————— D. Module slot number
SynChLink_MOdUIe_S|ave' Desciiglion:  [5lave chassis receives 2 anes of ;I iS 3 as ShOWﬂ in the
data at 250 mi ds. H
i pottls desblec. o graphic on page B-1.
B. Receive Port Comm Format is ———————— —Feceive Fort-EommFomat 2 A 4
2 AXiS to matCh the Transmit Transmit Part Comm Format gyo Transmit Data j

Port Comm Format of the
master module.

C. Transmit Port Comm Format is
No Transmit Data.

Electroric Keying: [ Compatible Module -] «—— E. Electronic Keying

method is Compatible
Next » | Firish >+ I Help | Modu|e.

Cancel | < Back |

F. Minor Revision = 1.

Module Properties - Local:2 [1796-5YNCH/A 1.1) [x]

G. Click here after
completing the
information on this page.

Requested Packet Interval = 20mS

Time Slave modules must be
configured as Time Masters for their
respective chassis if you want to
synchronize each chassis’ CST time
value with the CST Time Master.

This module must also NOT be
configured as the CST master of
the SynchLink (i.e. the box is
unchecked)
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™ Inkibit Madule

™ Major Fault On Contraller IF Connectian Fails 'While in Fun Mods

Madule Fault

Frequestod Pasketint

toaHEFH— - 20.0=Hms  [2.0-750.0 m3)

< Back | Mest >

Finish >3 Help
| ]

Cancel |

Module Properties - Local:1 [1756-5YNCH/A 1.1)

Click here to continue to the next screen.

> Make this module the Coordinated
Swstem Time Master for the chassis.

Make thiz module the Coordinated
/; System Time Master for the SynchLink.

turned off

AMGER: If this setting is cleared
orling, all active servo aes in any
controller in the chassis will be

Cancel | < Back | Mext >

Finigh >3 Help
| I |

Click here to finish configuration. This module does not transmit SynchLink
axis or direct words so the screens shown on pages B-5 & B-6 are not used.



Configuring the Star Configuration

B-11

A. Select Controller Tags.
B. Right-click to display
the menu.

Create Axis Data Tags

You must create axis data tags for the controller in this chassis to
consume. The axis data is originally produced in the Time Master
chassis and broadcast to SynchLink modules in other chassis over the
fiber optic cable. SynchLink modules in each Time Slave chassis then
consume the data from the cable and produce it in the local chassis.

The owner controller in their local chassis consumes the data from the

local

SynchLink module.

Follow these steps to create axis data tags in the consuming chassis:

1. Create a New Tag for Axis 0.

% RSLogix

5000 - Time_Slave_End_|

File Edit ¥iew Seach Logic Commu

Path: I <none>

. T RUN
| ok
= [T BAT

= [Pl

Offline
Mo Forces
Mo Edits

C. Select New Tag.

A. Name the new tag.

B. Change the Tag Type
to Consumed.

C. Use the pull-down menu

to change the Producer to
the SynchLink module in
the local chassis.

D. Type in the Remote Tag
Name. This name must
either be Axis0 or Axis1.
IMPORTANT: If you use any
Remote Tag Name other
than Axis0 or Axisl, the
remote axis data will NOT
be consumed.

5] Controller Time_Slave_End |
El
ESEEEIEL S Mew Tag
235;”"”‘ Moritor Tags
8 MainTag) EGtTa9
BB Main | o
F Export Tags..
B2 P
New Tag
M T‘EUr|sumed_Axls_A_lrnm_SynchLlnk
Description: ;I Cancel |
ﬂ Help |
Tag Type: " Base
 plias
" Produced |2 j COTSUTIETS
& Concumed
Frod i TEhLiRk_Modne_Slave Ei i mis]:
is0 [Fooo =
2 IAX\S . Canfigure. .. |
3
I i

E.

Change the Data Type to Axis.

F. Click on OK to create the new tag.
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B-12  Configuring the Star Configuration

2. Create a new tag for Axis 1. The tag should look like the
example below.

A. Name the new tag. Mt oruumed fvic_B_fom Symehlink [ 4+——— F Clickon OK to create the new tag.
Description: =] Cancel |
;I Help |

TagType: Base

B. Change the Tag Type M=
to Consumed. » Corsumed =

C. Use the pull-down menu Fred T Ep o | s
to change the Producer to
the SynchLink module in
the local chassis.

D. Type in the Remote Tag
Name. This name must
either be Axis0 or Axis1.
IMPORTANT: If you use any )
other Remote Tag Name E. Change the Data Type to Axis.
(other than Axis0 or Axis1)
the remote axis data will
NOT be consumed.

i1 ISD.DDD :1'

2 |A>i\5 _I Configure. .. |
I K

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
File Edit Yiew Search Lo

|
ﬁ Path: |4B_ETH-14130.1¢
A. Click on the triangle to i

see the pull-down menu. [||| ecehe
H Select Recent Path...

‘P GoOrline
i 1 Upload
B. Click on Download. — | L y——

Eragranm iede:
| Hur e
H Testivode

Lochk EartralEer

[Elear Fanlts
[z T Faults:

RSLogix 5000 verifies the download process with this pop-up screen.

Download

Download to the controller
Mame: Uszer_doc
Type: 17561174 1756-M0/0 LOGI<5550

Using this communications configuration:

Driver: AB_DF1-1
Pathy

Click here to download new data

Cancel |

This completes the download process.
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Configuring the Star Configuration B-13

— SynchLink

«— Time Slave
Chassis

ControlNet

Configure Time Slave Chassis - End Node

You must complete the following tasks to configure the second CST
Time Slave chassis. This set of tasks is exactly the same as those
described on page B-8 for the first End Node but are repeated here.

» Create a New RSLogix 5000 Project
» Add a SynchLink Module
 Configure the SynchLink Module
— Name the module
— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option
— Set the RPI
— Set the module as the CST Time Master for the chassis
 Create Axis Data Tags
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

B Edt View Seach Logic Com

Choose a New project —————— T

from the File menu.

New Controller =]

Wendor. Allen-Eradley
-

Open Cok0 |
Oicse
Seve 5
Geve s
New Component 3
Eompac:
Efit il
Fiint Options...
1 C5T _Time_Master ACD
2 Synch._Link ACD
e

2. Name the controller.

A. The controller is a 1756-L1.

B. The controller is named

F. Click here to use the

=|'|755-u ControlLogis 5550 Cortoler = | [il3 j—

I~ Redundancy Ensbled Cancel new controller.
#T.me,ﬁ\avejnd,w ode_2 Help

Time_Slave_End_Node_2.

Deseription:

C. The controller is used in a
7-slot chassis.

B
-]
' 7|
/ﬂﬂ‘ﬂ Revisin: 7 [F =
D. The controller’s slot location Cigatan: [ \RSLosi B000iPrjects Bronse

is 0.

Fypebe{ 175647  7-Slot ControlLogi Chassis

Publication 1756-UM521A-EN-P - August 2001



B-14  Configuring the Star Configuration

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces

IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

E

E

A. Select I/0 Configuration.
B. Click on the right mouse button
to display the menu.

C. Select New Module

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

A. Select a 1756-SYNCH module———»

Controller T

E1-48 MainTask

- EHER MairProgram
i Pragram Tags
MainFoutine

L[ Unscheduled Programs

[ Trends

755 Data Types

-4 Controller Synchlink

ags

(2 Controller Fault Handler
(23 PowerUp Handler
55 Tasks

i[O, UserDefined

£ Stings

P STRIN
L, Predefined
: le-Del

G

fined

[Euit
[Eopy

Easte

{ige

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay

1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

Link Bridge

-
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— Shuo
Yendor: IAII j IV Other [ Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear &ll |
QK I Cancel | Help |
%
B. Click here




Configuring the Star Configuration B-15

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1756-5YNCH/A 1.1)
Type: 175E-5YMCH AL Synchlink Interface
Wendor: Allen-Bradley
Farent: Local
A. Module name is — p-MName: ISynchLink_ModuIa_SIave Slot; |3 ::II - D MOdUIe S|0t number
Time_Slave_End_Node 1. Descrigion.  [Sisve chaseis raseives 2 aves of 2] is 3 as shown in the
data at 250 microseconds H
Transmit port iz disabled. ;I graphlc on page B-l

B. Receive Port Comm Format iS ————— —FecsiveorSommFomatf2 Axis

=
2 AXiS. Wo Tranzmit Data j
C. Transmit Port Comm Format is

No Transmit Data. Beviion: [ \ = Electronic Keying: [Compatible Module ~| «—— E. Electronic Keying
method is Compatible

Cancel | < Back | Mext > | Finish >3 I Help | Module.

F.  Minor Revision = 1. G. Click here after
completing the
information on this page.

Requested Packet Interval = 20mS BequesiedPacketintevaHRy—p— 200 ms  [20-750.0ms)
I Inkibit Module

™ Major Fault On Controller If Connection Fails Wil in Bur Mods
Maodule Fault

Cancel | < Back | Nexgt » | Finish >3 I Help

Click here to continue to the next screen.

Module Properties - Local:1 [1756-SYNCH/A 1.1)

I ake thi dule the Coordinated 7] I ake thi dule the Coordinated
Time slave modules must be e e et pedaes, | | S T vt o e BymchLirk
configured as Time Masters for
their respective chassis if you
want to synchronize each
chassis’ CST time value with the & DAMNGER: IF this setting is cleared

. onling, all active servo akes in any
CST Time Master.

contraller in the chassis will be
tuined off.

Cancel | < Back | Mexst » | Finigh > I Help |

Click here to finish configuration. This module does not transmit SynchLink
axis or direct words so the screens shown on pages B-5 & B-6 are not used.
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B-16  Configuring the Star Configuration

Create Axis Data Tags

You must create axis data tags for the controller in this chassis to
consume. The axis data is originally produced in the Time Master
chassis and broadcast to SynchLink modules in other chassis over the
fiber optic cable. SynchLink modules in each Time Slave chassis then
consume the data from the cable and produce it in the local chassis.
The owner controller in their local chassis consumes the data from the
local SynchLink module.

Follow these steps to create axis data tags in the consuming chassis:

1. Create a New Tag for Axis 1.

So. RSLogix 5000 - Time_Slave_End_|

File Edit ¥iew Seach Logic Commu

Path: I <none>

. T RUN
| ok
= [T BAT
2 [

Offline
Mo Forces
Mo Edits

A. Select Controller Tags.

B. Right-click to display
the menu.

C. Select New Tag.

[ Power-Us
Tasks Monitor Tags

8 MainTag) EGtTa9
BB Main | o
F Export Tags..
b Pint

73 Ve rbad,
MNew Tag
A. Name the new tag. U fonsumed tis__om Smenirk | |0k <4+———  F. Clickon OK to create the new tag.
Description: ;I Cancel |
ﬂ Help |
Tag Type: " Base
 plias
B' Change the Tag Type  Produced |2 ::II GONSUTETS:
to Consumed. ' Consumed
C. Use the pull-down menu P feprerRr et ] FElie)
tﬁ changﬁ thi Progulcer to o Fw g
the SynchLink module in
the local chassis. ' IMSS | _conliure. |
D. Type in the Remote Tag I I7|

Name. This name must
either be Axis0 or Axis1.
IMPORTANT: If you use any
other Remote Tag Name
(other than AxisO or Axis1)
the remote axis data will
NOT be consumed.
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Configuring the Star Configuration B-17

2. Create a new tag for Axis 1. The
example below.

A. Name the new tag.

B. Change the Tag Type
to Consumed.

C. Use the pull-down menu
to change the Producer to
the SynchLink module in
the local chassis.

D. Type in the Remote Tag
Name. This name must
either be Axis0 or Axis1.
IMPORTANT: If you use any
other Remote Tag Name
(other than Axis0 or Axis1)
the remote axis data will
NOT be consumed.

A. Click on the triangle to

see the pull-down menu.

B. Click on Download.

Hasme: ‘1€ur|sumed7A><is,B,lromﬁSynchLink —
Description: =] Cancel |
;I Help |
Tag Type: " Base
€ Alias
" Produced |2 = corsumers
- =]
B& Consumed
Frod i nchLink_fodute_Siave :i RN
is1 Jroo =
2 415 . Configure...
ro—

| i

E. Change the Data Type to Axis.

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
File Edit Yiew Search Lo

| [
ﬁ Path: J4B_ETH-14130.1¢

et = e
| I wiho Active [
H Select Recent Path...

‘[ GoOnline
Upload

Download

Eragranm iede:
| Hur e
H Testivode

Lochk EartralEer

[Elear Fanlts
[z T Faults:

tag should look like the

F. Click on OK to create the new tag.
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B-18  Configuring the Star Configuration

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3
Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data Cancel |

This completes the download process.
When all the chassis in the Star Configuration are configured and

operating online (i.e. configuration was downloaded) the chassis
synchronize with the CST Time Master.
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Appendix C

The SynchLink module in RN BER

this chassis is configured Master Node 3

as the Time Master for =
=s=ss

the for the SynchLink.

Configuring the Daisy Chain Configuration

This appendix provides a sample configuration for a SynchLink
system using the Daisy Chain Configuration. The system’s physical
configuration is shown in Figure C.1. In this configuration, you must:

« configure the Master Node in an RSLogix 5000 project.
« configure the Center Node in an RSLogix 5000 project.
« configure the End Node in an RSLogix 5000 project.

Figure C.1

L e

((ﬁ

o e

Center Node

o e

i de.

[ |

=
ey

©

A

SynchLink —— ControlNet

42883

The SynchLink modules in these chassis
are configured as the CST Time Masters.
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C-2  Configuring the Daisy Chain Configuration

Configure Time Master Chassis - Master Node

Time Master Chassis

You must complete the following tasks to configure the time
master chassis.

» Create a New RSLogix 5000 Project

» Add a SynchLink Module

ControlNet SynchLink » Configure the SynchLink Module

— Name the module

— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option

— Set the RPI

— Determine if the module is the CST Time Master for
the chassis

— Make the module the Time Master for the SynchLink
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

B Edt View Seach Logic Com

Choose a New project —————— T

. Open Chl+d £
from the File menu. o
Save LChifsE
Saye s
New Component »
[SEMEECE
e [t/
Frint Options...
1C5T_Time_Master ACD

2. Name the controller.

Wendor, Allen-Bradley
A. The controller is a 1756-L1. e P76 Comtollog 5560 Conoler =] K4 E. Click here to use the
I~ Redundancy Enabled S new controller.

B. The controller is named Meme———po{Time_ssler_chassis Heln

Time_Master_chassis. Desciptor: =

) ) &

C. The controller is used in a EhassisFrpel 175647 7-5lol Control ogis Chasei |

7-slot chassis. /m./ﬂ Revison: [ [F =
D. The controller slot number Cisstelie  [5RSLog SUT et Browse

is 0.
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Configuring the Daisy Chain Configuration

A. Select 1/0 Configuration.

B. Click on the right mouse button
to display the menu.

C. Select New Module

A. Select a 1756-SYNCH module———»

Add a SynchLink Module

1. Select a SynchLink module as shown below.

', RSLogix 5000 - SpnchLink [17564

File Edt iew Seach Logic Comm

Offline -

B4y

m Path: [BE_ETHII30.151.136.1

No Forces

Forces Disal

[HoEdts =

blec

Path:™ 4B_ETH-14130.151.136.164%\Backp

El antroller SynchLink
§ Conmaller Tags
3 Controller Fault Handler
(23 Powerlp Handler
B3 Tasks
£ 58 MainTask
| B3 MainProgram
Program Tags
L.[H] MainRoutine
(3 Unscheduled Programs
[ Trends
-5 Data Types
- UserDefined
£ £3 Stings
[ STRING
-, Predefined
£ Module-Defined

3

Lot
[Eapy
Faste

Firit

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L
1 756-0FEC] £ Charnel lsolated Curent Analoe (e [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uurpue
1756-0Hal 8 Paint 900-148Y DC |zolated Output
1756-0M8 8 Paint 100W-300 AC Dutput
1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay
1756-0-81 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch
nk. Bridge -
— Shuo
Wendar: IAII j ¥ Other W Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear All |
Of I Cancel | Help |
+
B. Click here
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C-4  Configuring the Daisy Chain Configuration

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Type: 1756-5YNCH /A SynchLink Interface
“endar: Allen-Bradley
Parert: Local
A. MOdUIe name IS — pMame IT\meﬁMaster Slat: |3 ﬁ<— D. Module slot number
Tlme_MaSter. Description: = | is 3 as shown in the
- graphic on page C-1.
B. Receive Port Comm Format is Rressive-Pert Semrm-Fermatie{ No Receive Dala =l

1 Ayis, 3 Direct words, 14 Buffered j

Electranic Keying ICompatibIe Madule ~le—— E. Electronic Keying

No Receive Data.

C. Transmit Port Comm Format is method is Compatible
2 Direct Words, 18 Buffered. Cancel | ook | Mews> | [ Finého> | Heb Module.
F. Minor Revision = 1. G. Click here after

completing the
information on this page.

Requested Packet Interval = 20mS Requested PackettemaHRRH P 20.0=ms (20 750.0ms]
™ Inkibit Madule

™ Major Fault On Controller If Connection Fails Whils in Fur Mods

Module Fault

Cancel | ¢ Back | Mest » | Finigh I Help

Click here to move to the next page

Module Properties - Locak:3 [1756-SYMCH/A 1.1)

SynchLink Transmitted Axes:

A 0 |<nnne>

This module does not transmit any ~ ——»
SynchlLink axes. Aais 1o e

Cancel | < Back | Mexf > | Finizh > | Help

Click here to move to the next page
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Configuring the Daisy Chain Configuration

C-5

S

The Module Identification page is
blank during initial configuration.

S

Module Properties - Local:1 [1756-SYMCH/A 1.1)

|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:
todule |dentity:
— Coordinated System Time [CST)
Tirner Hardware:
Timer Sync'ed EEfrest | Fieset Mndulel

Cancel | < Back I Mext > I Finizh > | Help |

Click here to move to the next page

Module Properties - Local:1 [1796-SYNCH/A 1.1) [ %]

— Transmitted Direct Words
Source:

The module transmits 2 Direct
Words, as specified in the transmit
port communications format.

The module is configured as the Time
Master for:

« the chassis - optional
« the SynchLink - required

IMPORTANT: In this configuration,
the SynchLink module must be the
Time Master of the SynchLink, but it
is not required to be the Time Master
of the chassis. If the module is not
the Time Master of the chassis, it
receives the CST timer value from the
chassis backplane.

I :IV
I :IV

L

Cancel | < Back I Mext > I Finigh > | Help

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

~ iMake this module the Coordinated 7/; Make this module the Coordinated
iSystem Time Master for the chassis: 1+ System Time Master for the SynchLink.

DAMGER: If thiz setting is cleared DANGER: If thiz setting is cleared
onling, all active servo axes in any online, all active servo axes in any
controller in the chassis will be chassiz dependent on this

turned off Coardinated System Time will be

turned off.

Cancel | < Back I Mext » I Finigh > I Help |
y

Click here to finish configuration.
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C-6  Configuring the Daisy Chain Configuration

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

I u
ﬁ Path: JAB_ETH-1413001%

A Click on the triangle to iijluﬁﬁruc ==im

see the pull-down menu. f||| dEreis
{ i Select Recent Path...

' F GoOnline
Upload...

B. Click on Download. — i Download

Brogram iade:

| B e
H Testiode

Lock Eartraler

[E{ear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3

Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data

Cancel |

This completes the download process.
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Configuring the Daisy Chain Configuration

C-7

Time Slave
Chassis

A. The controller is a 1756-L1.

B. The controller is named

C. The controller is used in a
7-slot chassis.
D. The controller’s slot location

ControlNet

SynchLink

Choose a New project
from the File menu.

Configure Time Slave Chassis - Center Node

You must complete the following tasks to configure the first time
slave chassis.

» Create a New RSLogix 5000 Project
» Add a SynchLink Module
 Configure the SynchLink Module
— Name the module
— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option
— Set the RPI
— Make the module the CST Time Master for the chassis

» Download Configuration
Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

dit Wiew Seach Logic Cor

Chrl+M
O Cukd L
Eferiz

Save Difhi)

Geve s

New Component 3

Compsst

Efit il

Fiint Options...

1 C5T _Time_Master ACD

2 Synch._Link ACD

Esit
e

2. Name the controller.

Time_Slave_Center_Node.

is 0.

New Controller =]
Wendor. Allen-Bradley
{1755 L1 ContolLogix 5550 Contraler 7| T F. Click here to use the
1= Fedundenoy Erreied Coancel new controller.
i Bo{Time_Slave_Center_Node Help

Deserigtion: =l

ShossisFopeB{ 175647 7-5lot Cortrollogis Chassis =l

Slat = Revsior: [ [T =

Cigateln: | \FSLagis BI00Frojects Browse..
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Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces

IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

E

E

A. Select I/0 Configuration.
B. Click on the right mouse button
to display the menu.

C. Select New Module

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

A. Select a 1756-SYNCH module———»

Controller T

E1-48 MainTask

- EHER MairProgram
i Pragram Tags
MainFoutine

L[ Unscheduled Programs

[ Trends

755 Data Types

-4 Controller Synchlink

ags

(2 Controller Fault Handler
(23 PowerUp Handler
55 Tasks

i[O, UserDefined

£ Stings

P STRIN
L, Predefined
: le-Del

G

fined

[Euit
[Eopy

Easte

{ige

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay

1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

Link Bridge

-
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— Shuo
Yendor: IAII j IV Other [ Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear &ll |
QK I Cancel | Help |
%
B. Click here




Configuring the Daisy Chain Configuration ~ C-9

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1756-SYNCH/A 1.1)
Type: 175E-5MCH /4 Synchlink Interface
Wendor: Allen-Bradey
Farent: Local
A. Module name is — p-MName: IT\me_SIava_Center_Node Slat: |3 :II - D MOdUIe S|0t number
Time_Center_Node. Descrighion: = is 3 as shown in the
. . raphic on page C-1.
B. Receive Port Comm Format is I grap bed

2 Direct Words, 18 Buffered to —————————FeesivePert-EommFermat-B2 Direct words, 18 Buifered =
match the upStream nOde’S Transmit Port Camm Format: Direct Words, 18 Buffered j
Transmit Port Comm Format.

Elestianic Keying: [Compatile odue || <——— E. Electronic Keying
C. Transmit Port Comm Format is method is Compatible
2 Direct WOI’dS, 18 Buffel’ed. Cancel | < Back | Next > | Finish > I Help | Module.
F. Minor Revision = 1. G. Click here after

completing the
information on this page.

Requested Packet Interval = 20mS Requesied PackettervaHRRHp—  200=ms  [20- 750.0ms)
™ Inkibit Madule

™ Major Fault On Controller If Connection Fails Whils in Fur Mods
Module Fault

Cancel | ¢ Back | Mext » | Finigh I Help

Click here to continue configuration.

Module Properties - Local:3 [1796-5YNCH/ A 1.1)

Synchlink Transmitted Axes:

Az : |<nune>

This module does not transmitany ~ ——=
SynchLink axes. A1 [erones

Cancel | <Back | Mg | Fnshos | Hep

Click here to move to the next page
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C-10  Configuring the Daisy Chain Configuration

@

The Module Identification page is
blank during initial configuration.

@

Module Properties - Local:1 [1756-SYMCH/A 1.1)

The module transmits 2 Direct
Words, as specified in the transmit
port communications format.

The first Direct Word transmits the
Multiplier value specifed in the
Local:x:0.Multiplier data tag.

Time slave modules must be
configured as Time Masters for their
respective chassis if you want to
synchronize the CST value in the
local chassis with the system CST
Time Master.
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|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:
todule |dentity:
— Coordinated System Time [CST)
Tirner Hardware:
Timer Sync'ed Fefrest | Heset Mndulel
Cancel | < Back I Mext > I Finizh > | Help |
Click here to move to the next page
Module Properties - Local:1 (1756-5YMCH/A 1.1) [x]
~ Transmitted Direct ‘Words
Source:
# | Multiplier -
1: | Dutput Direct Word 1 b
2 I ¥
3 I ¥

Cancel |

< Back I Mest > I Finish »> | Help

B

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

iMake this module the Coordinated |

r Make this module the Coordinated
iSystem Time Master for the chassis;

System Time Master for the SynchLink.

DAMGER: If thiz setting is cleared
onling, all active servo axes in any
caontroller in the chassiz will be
turned off

<Back | Mewt> |[ Fmsher | Heb |

A

Cancel |

Click here to finish configuration.



Configuring the Daisy Chain Configuration ~ C-11

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

|
Ea Path: |4B_ETH-14130.1%
A. Click on the triangle to i

see the pull-down menu. f||| ddEee

Select Recent Path...

Go Onling
. 1 Upload...
B. Click on Download. ——— T

I Brogram ade:
| Ftum ade
H Testiode

Lock Eartraler

[Elear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3

Download o the contraller:
Mame: User_doc

Type: 1756-L144 1756-M0/0 LOGI-5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data

Cancel |

This completes the download process.
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C-12

Configuring the Daisy Chain Configuration

Time Slave Configure Time Slave Chassis - End Node
Chassis

You must complete the following tasks to configure the second Time

Slave chassis.

C. The controller is used in a -BhassisFyp ='||?SE-A7 7-5lot ControlLogix Chassis

C|

|

||

7-slot chassis. /sn.ﬂ Redsionr £ [F 2
D. The controller’s slot location Crestelre  [C:\RSLog S000Frojects Brawsa

» Create a New RSLogix 5000 Project
» Add a SynchLink Module
ControlNet Synchtink « Configure the SynchLink Module
— Name the module
— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option
— Set the RPI
— Make the module the CST Time Master for the chassis
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

B Edt View Seach Logic Com

Choose a New project ———— = ENCTIN

. Open Chl+d £
from the File menu. o
Save LChifsE
Saye s
New Component »
[SEMEECE
e [t/
Frint Options...
1C5T_Time_Master ACD
2 Synch_Link ACD
Exit
[ |

2. Name the controller.

Vendor AllerBradiey
A. The controller is a 1756-L1. Toe {1751 CortiolLogix 5550 Controller v | x_ ¥+ F. Click here to use the
I=| Hedundaricy Ensbled Cancel new controller.
B. The controller is named Hegme———o{Tire_Slave_End Node Heln

Time_Slave_End Node. Descrption:

is 0.
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Configuring the Daisy Chain Configuration ~ C-13

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

] &) §
Bﬁ Patt [BE_ETH-14130.151 136 1644
[ho Edits | [Forces Dissbiec

Path:™ 4B _ETH-14130.151.136 164%Backp

=3 Controller SynchLink
L@ Contioller Tags

-3 Controller Fault Handier

[ PawerLp Handler

B3 Tasks

E-48 MainTask

- BB MainProgiam

B Program Tags

MainFoutine

L[ Unscheduled Programs

[T Trends
. . -5 Data Types
A. Select 1/0 Configuration. o bt
B. Click on the right mouse button R S e

L, Predefined
: le-Defined

to display the menu.
C. Select New Module S

[Euit
[Eopy

Easte

{ige

Select Module Type [ x|

b ajor B evision:

Type:
|1?58-SYNEH£A 1 ~| «—— Make sure the

Type | Diesciiption Major Revision

1756-0C8 8 Paint 300-600 DC Output number matches -

170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the

1756-0FEY] & Channel |solated Voltage Analor gjde of your module

1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu

1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink

1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay

1756-0-81 8 Paint 100-268 AC, 5v-150% DC |solated Relay N.O./M.C.

1756-FLS /B 1756 Programmable Lirmit Switch

A. Select a 1756-SYNCH module———» SynchLink Bridge =

— Shuo
Wendar: |4l | W Other W Specalyl/n | SelectAl |
W fnalog W Digtdl W Commurication W Motion W Processor Clear &l |

QK I Cancel | Help |

B. Click here
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C-14  Configuring the Daisy Chain Configuration

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1796-5YNCH/A 1.1)

Type:
YYendar:
Farent:
A. Module name is — plane
Time_SIaVe_End_NOde. Description:

B. Receive Port Comm Format is

2 Direct Words, 18 Buffered to —————————fecsivePert EommFormat: B2 Diect Words, 18 Bufered

match the upsteam device’s
Transmit Port Comm Format.
C. Transmit Port Comm Format is

BRevision:

Tranzmit Part Comm Format:

175E-5MCH /4 Synchlink Interface

Allen-Bradey
Local

IT\me_SIava_End_N ode

=

Slgt: |3 j - D
=l
<]
=
o Transmit Data j

Electranic Keying: ICompatibIe Module 'l -« E.

No Transmit Data.

Cancel | < Eiach | Mext > | Finizh »» I Help |
F. Minor Revision=1. G. Click here after
completing the
information on this page.
Requested Packet Interval = 20mS FearestedRacketintermaHARH: 200 ms  [20-750.0ms)
™ Inkibit Maduls
™ Major Fault On Controller If Connection Fails Wil in Fun Mods
todule Fault
Cancel | < Back | et | Firigh 32 I Help
Click here to continue configuration.
Time slave modules must be —_— iMake this module the Coordinate r Make thiz module the Coordinated
. . System Time Master for the chas: Systemn Time Master for the Synchlink.
configured as Time Masters for
their respective chassis. With this
setting, the Time Slave module
passes the CST value (received & DANGER: If this selfing is cleared
. . anling, all active servo axes in any
from the Time Master ChaSS|S) to controller in the chassis will be
. turned off.

the local chassis backplane and all
the devices in the chassis. .

Cancel < Back | Mewt > | Finigh > Help |
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Click here to finish configuration.

. Module slot number

is 3 as shown in the
graphic on page C-1.

Electronic Keying
method is Compatible
Module.



Configuring the Daisy Chain Configuration ~ C-15

Module Properties - Local:1 [1756-SYMCH/A 1.1)

|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
The Module Identification page is Fievision:
blank during initial configuration. s eial Number Configured
Praduct Name: Dwned:
todule |dentity:
— Coordinated System Time [CST)
Tirner Hardware:
Timer Sync'ed Fefrest | Heset Mndulel

Cancel | < Back I Mext > I Finizh > | Help |

Click here to move to the next page

Module Properties - Local1 [1756-5YMCH/A 1.1)

r~ Transmitted Direct Words
Source:

As the end node in the Daisy Chain >
configuration, this module does not ‘2: |
e

transmit any Direct Words.

Cancel | < Back I Mest > I Finigh »» | Help

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

r Make this module the Coordinated

Time SlaVe mOdules must be I# B e o R e System Time Master for the SynchLink.

Systemn Time Master for the chassis.
configured as Time Masters for their
respective chassis if you want to
synchronize the CST value in the
local chassis with the system CST & ol 3t servs e o
Time Master.

caontroller in the chassiz will be
turned off

Cancel | < Back | Mext » | Finigh > I Help |

A

Click here to finish configuration.
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C-16  Configuring the Daisy Chain Configuration

A. Click on the triangle to
see the pull-down menu.

B. Click on Download.

Click here to download new data

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

I
ﬁ Path: J4B ETH-1413001¢

1 Wha Active
: Select Recent Path...

Go Onling
Upload...

Download

I Brogram ade:
| Ftum ade
H Testiode

Lock Eartraler

[Elear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3

Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Cancel |
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This completes the download process.

When all the chassis in the Daisy Chain Configuration are configured
and operating online (i.e. configuration was downloaded) the chassis
synchronize with the CST Time Master.



Appendix D

Configuring the Ring Configuration

This appendix provides a sample configuration for a SynchLink
system using the Ring Configuration. The system’s physical
configuration is shown in Figure D.1. In this configuration, you must:

« configure the Master Node in an RSLogix 5000 project.
« configure the Center Node in an RSLogix 5000 project.
« configure the End Node in an RSLogix 5000 project.

Figure D.1
Th_e SynChLmk mOd_U|e in ° \:75\ o o] 6 de. SEEEREE= SEENREENEE
this chassis is configured —» Master Node == , Center Node =1 ,= Center Node
as the Time Master for B E= g = | == ——
A . % e
] & =5

the for the SynchLink. T \

,,f ,,,,,,, [— — B _ [ I
SynchLink ——» ControINet \ /
v _ y -

Y 42883

e
- -

- -

The SynchLink modules in these chassis
are configured as the CST Time Masters.

YT esNGd You can use a maximum of 10 nodes in the Ring
configuration. In this configuration, you must

configure all chassis that are Time Slave chassis on
SynchLink as CST Time Master for the local chassis.

Also, in the Star and Daisy Chain configurations, the
Master Node does not receive data. But in the Ring
configuration, the Master Node receives data from
the End Node. Make sure the Master Node’s receive
port communications format matches the End Node's
transmit port communications format.
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D-2  Configuring the Ring Configuration

Configure Time Master Chassis - Master Node

Time Master Chassis

You must complete the following tasks to configure the time
master chassis.

» Create a New RSLogix 5000 Project

- » Add a SynchLink Module

ControlNet SynchLink 45080  Configure the SynchLink Module

— Name the module

— Choose a receive communications format
— Choose a transmit communications format
— Choose an electronic keying option

— Set the RPI

— Determine if the module is the CST Time Master for
the chassis

— Make the module the CST Time Master for the SynchLink
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

B Edt View Seach Logic Com

Choose a New project —————— T

. Open Chl+d £
from the File menu. o
Save LChifsE
Saye s
New Component »
[SEMEECE
e [t/
Frint Options...
1C5T_Time_Master ACD

2. Name the controller.

Wendor, Allen-Bradley
A. The controller is a 1756-L1. e P76 Comtollog 5560 Conoler =] K4 E. Click here to use the
I~ Redundancy Enabled S new controller.

B. The controller is named Meme———po{Time_ssler_chassis Heln

Time_Master_chassis. Desciptor: =

) ) &

C. The controller is used in a EhassisFrpel 175647 7-5lol Control ogis Chasei |

7-slot chassis. /m./ﬂ Revison: [ [F =
D. The controller slot number Cisstelie  [5RSLog SUT et Browse

is 0.
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Configuring the Ring Configuration

A. Select 1/0 Configuration.

B. Click on the right mouse button
to display the menu.

C. Select New Module

A. Select a 1756-SYNCH module———»

Add a SynchLink Module

1. Select a SynchLink module as shown below.

', RSLogix 5000 - SpnchLink [17564

File Edt iew Seach Logic Comm

Offline -

B4y

m Path: [BE_ETHII30.151.136.1

No Forces

Forces Disal

[HoEdts =

blec

Path:™ 4B_ETH-14130.151.136.164%\Backp

El antroller SynchLink
§ Conmaller Tags
3 Controller Fault Handler
(23 Powerlp Handler
B3 Tasks
£ 58 MainTask
| B3 MainProgram
Program Tags
L.[H] MainRoutine
(3 Unscheduled Programs
[ Trends
-5 Data Types
- UserDefined
£ £3 Stings
[ STRING
-, Predefined
£ Module-Defined

3

Lot
[Eapy
Faste

Firit

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L
1 756-0FEC] £ Charnel lsolated Curent Analoe (e [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uurpue
1756-0Hal 8 Paint 900-148Y DC |zolated Output
1756-0M8 8 Paint 100W-300 AC Dutput
1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay
1756-0-81 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch
nk. Bridge -
— Shuo
Wendar: IAII j ¥ Other W Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear All |
Of I Cancel | Help |
+
B. Click here
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D-4  Configuring the Ring Configuration

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Type: 1756-5YNCH /A SynchLink Interface
“endar: Allen-Bradley
Parert: Local
A. MOdUIe name IS — pMame IT\meﬁMaster Slat: |3 ﬁ<— D. Module slot number
Tlme_MaSter. Description: = | is 3 as shown in the
- graphic on page D-1.
B. Receive Port Comm Format is Reseive-Port EarmrFormatps 2 Direct words, 18 Buffered =l

2 Direct 'w/ords, 18 Buffered |

Electronic Keying IW% E. Electronic Keylng
method is Compatible

Cancel | < Back | Mext > | Finish »> I Help Module.

2 Direct Words, 18 Buffered to
match the end node’s Transmit
Port Comm Format.

C. Transmit Port Comm Format is
2 Direct Words, 18 Buffered.

F. Minor Revision = 1. G. Click here after
completing the
information on this page.

Requested Packet Interval = 20mS Requested PackettemaHRRH P 20.0=ms (20 750.0ms]
™ Inkibit Madule

™ Major Fault On Controller If Connection Fails Whils in Fur Mods

Module Fault

Cancel | ¢ Back | Mest » | Finigh I Help

Click here to move to the next page

Module Properties - Locak:3 [1756-SYMCH/A 1.1)

SynchLink Transmitted Axes:

A 0 |<nnne>

This module is not transmitting any ———»
SynchlLink axes. Aais 1o e

Cancel | < Back | Mexf > | Finizh > | Help

Click here to move to the next page
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Configuring the Ring Configuration

D-5

S

The Module Identification page is
blank during initial configuration.

S

Module Properties - Local:1 [1756-SYMCH/A 1.1)

|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:
todule |dentity:
— Coordinated System Time [CST)
Tirner Hardware:
Timer Sync'ed EEfrest | Fieset Mndulel

Cancel | < Back I Mext > I Finizh > | Help |

Click here to move to the next page

Module Properties - Local:1 [1756-5YNCH/A 1.1) [ x]

r Transmitted Direct \Words
Source:

The module transmits 2 Direct
Words, as specified in the transmit
port communications format.

The module is configured as the Time

Master for: /
« the chassis - optional

« the SynchLink - required
IMPORTANT: In this configuration,
the SynchLink module must be the
Time Master of the SynchLink, but it
is not required to be the Time Master
of the chassis. If the module is not
the Time Master of the chassis, it
receives the CST timer value from the
chassis backplane.

Output Direct 'Word 0 -
Output Direct 'ord 1 -

L e

Cancel | < Back I Mext > I Finigh »> | Help

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

[] Make this module the Coordinated
/F System Time Master for the SynchLink.

iMake this module the Coordinated |
System Time Master for the chassis:

DAMGER: If thiz setting is cleared DANGER: If thiz setting is cleared
onling, all active servo axes in any online, all active servo axes in any
controller in the chassis will be chassiz dependent on this

turned off Coardinated System Time will be
turned off.

Cancel | < Back I Mext » I Finigh > I Help |
y

Click here to finish configuration.
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D-6  Configuring the Ring Configuration

Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

I u
ﬁ Path: JAB_ETH-1413001%

A Click on the triangle to iijluﬁﬁruc ==im

see the pull-down menu. f||| dEreis
{ i Select Recent Path...

' F GoOnline
Upload...

B. Click on Download. — i Download

Brogram iade:

| B e
H Testiode

Lock Eartraler

[E{ear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3

Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data

Cancel |

This completes the download process.

Publication 1756-UM521A-EN-P - August 2001



Configuring the Ring Configuration D-7

Time Slave Configure Time Slave Chassis - Center Node
Chassis

You must complete the following tasks to configure the first time
slave chassis.

» Create a New RSLogix 5000 Project

b » Add a SynchLink Module

ControlNet SynchLink 42000 * Configure the SynchLink Module

— Name the module

— Choose a receive communications format

— Choose a transmit communications format

— Choose an electronic keying option

— Set the RPI

— Make the module the CST Time Master for the chassis

» Download Configuration
Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

dit ¥iew Seach Logic Com

Clrl+H

Choose a New project ————— i

. Op Chl+d £
from the File menu. o
Save LChifsE
Saye s
New Component »
Bipeiett
e [t/
Frint Options...
1C5T_Time_Master ACD
2 Synch_Link ACD
Exit
[ |

2. Name the controller.

Wendor. Allen-Bradley
A. The controller is a 1756-L1. Spe—Bf175611  CorroLog 5550 Comaler  ¥] | 0K F. Click here to use the
I=| Fedundancy Ertled Cancel new controller.

B. The controller is named esee——po{Tie_Slave_Certer_Node Help

Time_Slave_Center_Node. i i 5

LI

C. The controller is used in a EhassieTrpolf1756.47 7500l ContiolLogix Chassi =l

7-slot chassis. s = Reviior: [ [ =
D. The controller’s slot location Digateln: [ \RSLogin S000Prajects Browse...

is 0.
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D-8  Configuring the Ring Configuration

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces

IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

E

E

A. Select I/0 Configuration.
B. Click on the right mouse button
to display the menu.

C. Select New Module

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

A. Select a 1756-SYNCH module———»

Controller T

E1-48 MainTask

- EHER MairProgram
i Pragram Tags
MainFoutine

L[ Unscheduled Programs

[ Trends

755 Data Types

-4 Controller Synchlink

ags

(2 Controller Fault Handler
(23 PowerUp Handler
55 Tasks

i[O, UserDefined

£ Stings

P STRIN
L, Predefined
: le-Del

G

fined

[Euit
[Eopy

Easte

{ige

b ajor B evision:

1 ~] <—— Make sure the

Type | Diesciiption Major Revision
1756-0C8 8 Paint 300-600 DC Output number matches -
170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay

1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

Link Bridge

-
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— Shuo
Yendor: IAII j IV Other [ Specialty 140 Select Al |
¥ &nalog W Digtal W Communication W Motion [V Processor Clear &ll |
QK I Cancel | Help |
%
B. Click here
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Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1756-SYNCH/A 1.1)
Type: 175E-5MCH /4 Synchlink Interface
Wendor: Allen-Bradey
Farent: Local
A. Module name is — p-MName: IT\me_SIava_Center_Node Slat: |3 :II - D MOdUIe S|0t number
Time_Center_Node. Descrighion: = is 3 as shown in the
. . raphic on page D-1.
B. Receive Port Comm Format is I 9rap Ped

2 Direct Words, 18 Buffered to —————————FeesivePert-EommFermat-B2 Direct words, 18 Buifered =
match the upStream nOde’S Transmit Port Camm Format: Direct Words, 18 Buffered j
Transmit Port Comm Format.

Elestianic Keying: [Compatile odue || <——— E. Electronic Keying
C. Transmit Port Comm Format is method is Compatible
2 Direct WOI’dS, 18 Buffel’ed. Cancel | < Back | Next > | Finish > I Help | Module.
F. Minor Revision = 1. G. Click here after

completing the
information on this page.

Requested Packet Interval = 20mS Requesied PackettervaHRRHp—  200=ms  [20- 750.0ms)
™ Inkibit Madule

™ Major Fault On Controller If Connection Fails Whils in Fur Mods
Module Fault

Cancel | ¢ Back | Mext » | Finigh I Help

Click here to continue configuration.

Module Properties - Local:3 [1796-5YNCH/ A 1.1)

Synchlink Transmitted Axes:

Az : |<nune>

This module does not transmitany ~ ——=
SynchLink axes. A1 [erones

Cancel | <Back | Mg | Fnshos | Hep

Click here to move to the next page
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D-10  Configuring the Ring Configuration

@

The Module Identification page is
blank during initial configuration.

@

Module Properties - Local:1 [1756-SYMCH/A 1.1)

The module transmits 2 Direct
Words, as specified in the transmit
port communications format.

The first Direct Word transmits the
Multiplier value specifed in the
Local:x:0.Multiplier data tag.

Time slave modules must be
configured as Time Masters for their
respective chassis if you want to
synchronize the CST value in the
local chassis with the system CST
Time Master.
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|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:
todule |dentity:
— Coordinated System Time [CST)
Tirner Hardware:
Timer Sync'ed Fefrest | Heset Mndulel
Cancel | < Back I Mext > I Finizh > | Help |
Click here to move to the next page
Module Properties - Local:1 (1756-5YMCH/A 1.1) [x]
~ Transmitted Direct ‘Words
Source:
# | Multiplier -
1: | Dutput Direct Word 1 b
2 I ¥
3 I ¥

Cancel |

< Back I Mest > I Finish »> | Help

B

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

iMake this module the Coordinated |

r Make this module the Coordinated
iSystem Time Master for the chassis;

System Time Master for the SynchLink.

DAMGER: If thiz setting is cleared
onling, all active servo axes in any
caontroller in the chassiz will be
turned off

<Back | Mewt> |[ Fmsher | Heb |

A

Cancel |

Click here to finish configuration.
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Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

|
Ea Path: |4B_ETH-14130.1%
A. Click on the triangle to i

see the pull-down menu. f||| ddEee

Select Recent Path...

Go Onling
. 1 Upload...
B. Click on Download. ——— T

I Brogram ade:
| Ftum ade
H Testiode

Lock Eartraler

[Elear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3

Download o the contraller:
Mame: User_doc

Type: 1756-L144 1756-M0/0 LOGI-5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data

Cancel |

This completes the download process.
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Time Slave Configure Time Slave Chassis - End Node
Chassis

You must complete the following tasks to configure the second Time
Slave chassis.

» Create a New RSLogix 5000 Project
L oo » Add a SynchLink Module

ControlNet Synchtink « Configure the SynchLink Module

— Name the module

— Choose a receive communications format

— Choose a transmit communications format

— Choose an electronic keying option

— Set the RPI

— Make the module the CST Time Master for the chassis
» Download Configuration

Create a New RSLogix 5000 Project

1. Use the File menu to create a new project.

%, RSLogix 5000

B Edt View Seach Logic Com

Choose a New project ———— = ENCTIN

. Open Chl+d £
from the File menu. o
Save LChifsE
Saye s
New Component »
[SEMEECE
e [t/
Frint Options...
1C5T_Time_Master ACD
2 Synch_Link ACD
Exit
[ |

2. Name the controller.

Wendor, Allen-Bradley
A. The controller is a 1756-L1. T 175611 ContolLogi 5550 Cortoler 7] ¥ F. Click here to use the
D Redhndancy Encied Cancel new controller.
B. The controller is named Heme———o{Tirs_Slsve_End_Node Help
Time_Slave_End Node. B |
-
C. The controller is used in a Ehesiebypell 175647 75kl Conrol og Chassis =
7-slot chassis. /snﬂ Redson: [ [ =)
D. The controller’s slot location Cresteln: [ \R5Logi S000Prejects Browse

is 0.
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Configuring the Ring Configuration D-13

A. Select I/0 Configuration.

B. Click on the right mouse button
to display the menu.

C. Select New Module

A. Select a 1756-SYNCH module———»

Add a SynchLink Module

1. Select a SynchLink module as shown below.

% RSLagix 5000 - SynchLink [1756-

File Edt View Seach Logic Comm

o] V1 e

| DGR ERREA N

0 e hat INn Forces
IND Edits vI Ianes Disablec

Path:™ 4B _ETH-14130.151.136 164%Backp

=3 Controller SynchLink
L@ Contioller Tags

-3 Controller Fault Handier

[ PawerLp Handler

B3 Tasks

E-48 MainTask

- BB MainProgiam

B Program Tags

MainFoutine

L.[73 Unscheduled Programs

[ Trends

£ Data Types

.0, UserDefined

£ Stings

P STRING

L, Predefined

: le-Defined

[Euit
[Eopy

Easte

{ige

Select Module Type

Tupe:
|1 FHE-SYNCH 4,

b ajor B evision:

Link Bridge

1 ~] <—— Make sure the
Major Revision |
number matches =

Type | Drescription

1756-0C8 8 Paint 300-600 DC Output

170E-0F4 4 Channel Mon-zolated Voltage /L

1 756-0FEC] £ Charnel lsolated Cuent Analoe (N [aDEl on the
1756-0FEY] & Channel |solated Voltage Analor gjde of your module
1756-0F8 8 Channel Mon- zolated Woltage/Lurrent anaidg uuipu
1756-0Hal 8 Paint 900-148Y DC |zolated Output

1756-0M8 8 Paint 100W-300 AC Dutput

1756-0%1BE A4 16 Paint 100-300 DC Electronically Fused Output, Sink
1756-0/ 16l 16 Paint 100-2654 AC. 51500 DC lzolated Relay
1756-081 8 Point 100-265 AL, 5-1580v DC lsolated Relay N.O./M.C.
1756-FLS /B 1756 Programmable Lirmit Switch

-

— Shuo
Wendor: IAII

j ¥ Other W Specialty 140 Select Al |

¥ &nalog W Digtal W Communication W Motion [V Processor

Clear All |

Cancel | Help |

B. Click here
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A. Module name is
Time_Center_Node.

B. Receive Port Comm Format is
2 Direct Words, 18 Buffered to
match the upstream node’s
Transmit Port Comm Format.

C. Transmit Port Comm Format is
2 Direct Words, 18 Buffered.

Requested Packet Interval = 20mS Requesied PackettervaHRRHp—  200=ms  [20- 750.0ms)
™ Inkibit Madule

This module does not transmitany ~ ——=

SynchLink axes.

Configure the SynchLink Module

1. Use the new module creation wizard as shown below.

Module Properties - Local [1756-SYNCH/A 1.1)

Type: 175E-5MCH /4 Synchlink Interface

Wendor: Allen-Bradey

Farent: Local
— p-MName: IT\me_SIava_Center_Node Slat: |3 :II - D. Module SIOt numbel’

Disorition: = is 3 as shown in the

= graphic on page D-1.

4F\-§eeive~F‘ﬁﬂ-Eamnﬁ—Fﬁfﬁ‘raF*2 Direct Words, 18 Buffered j

Transmit Port Camm Format: Direct Words, 18 Buffered j

Electroric Keying: [ Compatible Module -] «—— E. Electronic Keying

method is Compatible

Cancel | < Biack | MNext > | Finizh > I Help | Modu|e.

F. Minor Revision = 1. G. Click here after
completing the
information on this page.

™ Major Fault On Controller If Connection Fails Whils in Fur Mods

Module Fault

Cancel | ¢ Back | Mext » | Finigh I Help

Click here to continue configuration.

Module Properties - Local:3 [1796-5YNCH/ A 1.1)

Synchlink Transmitted Axes:

Az : |<nune>

Az 1: |<nnne>

Cancel | <Back | Mg | Fnshos | Hep

Click here to move to the next page
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@

The Module Identification page is
blank during initial configuration.

@

Module Properties - Local:1 [1756-SYMCH/A 1.1)

|dentification Statu
endor: ajor Fault:
Product Type: tdinor Fault:
Product Code: Internal State:
FRevision:
Serial Number Corfigured:
Praduct Name: Dwned:

todule |dentity:

— Coordinated System Time [CST)
Tirner Hardware:

Timer Sync'ed Fefrest | Heset Mndulel
Cancel | < Back I Mext > I Finizh > | Help |

Click here to move to the next page

Module Properties - Local:1 [1796-SYNCH/A 1.1) [ %]

— Transmitted Direct Words
Source:

Output Direct \Word O h

The module transmits 2 Direct
Words, as specified in the transmit
port communications format.

Time slave modules must be
configured as Time Masters for their
respective chassis if you want to
synchronize the CST value in the
local chassis with the system CST
Time Master.

L
2
N —

Cancel | < Back

I Mext I

Finish»> |

Help

B

Click here to move to the next page

Module Properties - Local:3 [1756-5YNCH/A 1.1)

iMake this module the Coordinated | r Make this module the Coordinated
iSustem Time Master for the chassis] System Time Master for the SynchLink.
DAMGER: If this setting is cleared
onling, all active servo axes in any
caontroller in the chassiz will be
turned off
Cancel | < Back | Mext » | Finigh > I Help |

A

Click here to finish configuration.
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Download Configuration

Download the configuration data.

| % RSLogix 5000 - Synchli
* File Edit “iew Search Lc

|
Ea Path: |4B_ETH-14130.1%
A. Click on the triangle to i

see the pull-down menu. f||| ddEee

Select Recent Path...

Go Onling
. 1 Upload...
B. Click on Download. ——— T

I Brogram ade:
| Ftum ade
H Testiode

Lock Eartraler

[Elear Faults
e e Faults

RSLogix 5000 verifies the download process with this pop-up screen.

Download E3
Download o the contraller:
Mame: User_doc
Type:  1756-L144 1756-M0/0 LOGI5550

Uzing thiz communications configuration:

Diriver: &B_DF1-1
Path:

Click here to download new data Cancel |

This completes the download process.
When all the chassis in the Ring Configuration are configured and

operating online (i.e. configuration was downloaded) the chassis
synchronize with the CST Time Master.
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Appendix E

Software Configuration Tags

Althou_gh this appendix present_s the option of
changing a module’s configuration through the Tag

Editor of RSLogix 5000, we suggest that you use the
module’s properties tabs to change configuration
when possible.

When you create a module, module-defined data types and tags are
created in the RSLogix 5000 programming software. These Tags allow
you to access the Input and Output Data of the module via the
controller’s ladder logic.

The types of tags created vary, depending on which communications
format you choose when creating a module. There are two types of
tags:

* Input Data Tags
* Output Data Tags

This appendix lists all the tags of each type, but the tags created by

RSLogix 5000 varies according to the communications format chosen
during initial module configuration.
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Accessing the Tags When you access tags, you have two options. You can:

» monitor tags - option allows you to view tags and change their
values

* edit tags - option allows you to add or delete tags but not
change values

:':b RS5Logix 5000 - SyncLink [1756-L1]

i File Edit “iew Seach Logic Communi

Path: [AE_KTC1\E\Backplane'a

Offline A, RN -]

Mo Forces b :: gAKT
Mo Edits = m o

. . El-E5 Contraler Synclink =
A. Right-click on Controller Tags. - =

. (5 Controler | M= Tag.
B. Select Monitor Tags. | 1 PowerLiopgmy
{ [ 5E Tacks Edlt Tags
E%‘ %ﬁ'ﬂas’; ety
: ST Export Tags...
Pro Export Tags.
ta  Print

You can view tags here.

Sha; | Show Al LI Sort ITag Mame j
Tag Mame 2 | Value € | Force Mask €| Siyle Ty
Click on the data type (input M Local 31 o) L.t 2B
or output) you want to see. =L fead fead b
[« T [\monitor Tags AEatTass /] 2
Scope: ISynchLink,UsaLMad Show: |5|’|0W All LI Sort ITag Mame j
Tag Mame 2 | Value € | Force Mask €| Siyle Ty
|=-Local 3! [ [ AB
» [+-Lacal 3:1. Fault Z#0000_000. .. Binary i}

. T —Locat 31 ChassisMultitd aster o Decimal BC
Informatlon IS IIStEd fOI’ eaCh I —Locat 31 ChassisCSTFault 1] Decimal BC
input and Output data type —Local 31 SynchLinkR=Fault 0 Decimal BC

—Local 3:1. SynchLinkD ataF ault 1] Decimal BLC
—Local 3. SynchLinkFormatF ault 1] Decimal BC
—Local 3:1. SynchLinkMultit aster 1] Decimal BC
—Local 3:1. SynchLinkCS TFault o Decimal BLC
—Local 31 SynchLinkCS TUneynch 1] Decimal BLC
—Local 3. SynchLinkMultiplierDverflow 1] Decimal BC_|
—Locak 31 RxAxisOF ault 1} Decirnal BC
Locak 31 Rudxis1Faulk 0 Decimal BC
—Locak 31 AxisON aCorsurner 0 Decimal BC
—Locak 3] AxisTMoConsumer 0 Decimal BC
—Locak 31 TrixisOF ault 1} Decirnal BC -
[T\ monttor Tags A et tags 74l | ,
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Software Configuration Tags ~ E-3

Input Data Tags Table E.1 lists the input data tags available on your

iISynchLink module.
Table E.1
Input Data Tags

Name Type: Definition:

(x =module’s chassis slot location):

Local.x.|.Fault DINT

Local.x.l.ChassisMultiMaster BOOL 0 = The chassis has no CST master or one CST master

1 =This module is configured to be CST master, but another module
is active as CST master.

Local.x.l.ChassisCSTFault BOOL 0 = Chassis CST value is not faulted.
1 = Chassis CST value is faulted.

Local.x.I.SynchLinkRxFault BOOL 0 = The module’s receive port is functioning properly.
1 = A fault has occurred on the module’s receive port.

Local.x.l.SynchLinkDataFault BOOL 0 = Either no data received from upstream module (see other faulty
bits) or upstream device not in idle state

1 = Upstream device producing data for this module is in the idle
state

Local.x.I.SynchLinkFormatFault BOOL 0 = The module’s communications formats are properly configured.
1 = This modules receive port communications format does not
match the upstream module's transmit port communications format

Local.x.l.SynchLinkMultiMaster BOOL 0 =One node is configured as the master of the SynchLink .
1 = Multiple nodes are configured as the master of the SynchLink.
Local.x.I.SynchLinkCSTFault BOOL 0 = Valid CST data received from upstream module or CST data not
required

1 = This module configured to relay CST from SynchLink to Chassis
and valid CST data not received from upstream module

Local.x.l.SynchLinkCSTUnsynch BOOL 0 = The module’s CST value is either synchronized with the rest of
the system or is configured so that synchronization is not required.
1 =The module is configured to synchronize its CST value with the
rest of the system but the synchronization has not occurred.

Local.x.I.SynchLinkMultiplierOverflow BOOL This field only shows a value if the result of Multiplier (i.e.
Local.x.0.Multiplier) exceeds 16 hits. This value here is the excess
over 16 bits of data.

Local.x.|.RxAxisOFault BOOL 0 = The module’s receive port is either receiving Axis0 data or is not

configured to receive such data.
1 = This module is configured to transmit AxisO data but is not
receiving AxisO data from local processor

Local.x.|.RxAxis1Fault BOOL 0 = The module’s receive port is either receiving Axis1 data or is not
configured to receive such data.

1 = This module is configured to transmit Axis1 data but is not
receiving AxisO data from local processor

Local.x.l.AxisONoConsumer BOOL 0 = Another device is consuming the AxisO data this module is
producing or this module is not configured to produce Axis0 data.
1 = No device is configured to consume the Axis0 data this module
produces.
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Table E.1
Input Data Tags
Name Type: Definition:
(x =module’s chassis slot location):
Local.x.l.AxisINoConsumer BOOL 0 = Another device is consuming the Axis1 data this module is
producing or this module is not configured to produce Axis1 data.
1 =No device is configured to consume the Axis1 data this module
produces.
Local.x.|.TxAxisOFault BOOL 0 =The module’s transmit port is transmitting Axis0 data or is not
configured to transmit such data.
1 =The module is configured to transmit AxisO data but is
experiencing a fault on that port.
Local.x.I. TxAxis1Fault BOOL 0 =The module’s transmit port is transmitting AxisO data or is not
configured to transmit such data.
1 =The module is configured to transmit AxisO data but is
experiencing a fault on that port.
Local.x.l.DirectData[0] through DINT These 4 fields vary according to the data contained the first direct
Local.x.|.DirectData[3] word the module receives.
Local.x.I.BufferedData[0] through DINT These 18 fields vary according to the data contained the first
Local.x.|.BufferedData[17] buffered word the module receives.
Local.x.l.MultiplierProduct DINT The product of the Multiplier and the selected Direct Word.
Output Data Tags Table E.2 lists the output data tags available on your
SynchLink module.
Table E.2
Output Data Tags
Name Type: Definition:

(x =module’s chassis slot location):

Local.x.0.DirectData[0] through DINT These fields contain the data that this module will transmit in the

Local.x.0.DirectData[3] direct data word if configured to transmit output direct words. The
module can transmit up to 4 output direct words.

Local.x.0.BufferedData[0] through DINT These fields contain the data that this module will transmit in the

Local.x.0.BufferedData[17] buffered data words. The module can transmit up to 18 buffered
data words.

Local.x.0.Multiplier REAL Coeeficient applied in multiplier feature, restricted to

0.5t02.0
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Glossary

Buffered data

Data exchanged between SynchLink nodes. The data is appropriately
segmented at the transmitting module and reassembled at the
receiving module. Buffered data cannot be automatically forwarded to
the next node in the daisy chain configuration.

Center node

A node in the SynchLink Daisy Chain or Ring configuration that
receives data and transmits data.

Communications format

Format that defines the type of information transferred between an
I/0 module and its owner controller. This format also defines the tags
created for each 1/0 module.

Compatible match

An electronic keying protection mode that requires the physical
module and the module configured in the software to match
according to vendor, catalog humber and major revision. In this case,
the minor revision of the module must be greater than or equal to that
of the configured slot.

Connection

The communication mechanism from the controller to another module
in the control system.

Coordinated system time (CST)
Timer value that is used in:
« all modules in a single ControlLogix chassis
or
« all ControlLogix chassis in a distributed control system.

The SynchLink system can synchronize this timer value across chassis.
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Daisy chain configuration

SynchLink configuration that begins with a master node and ends at
an end node. Center nodes may be used between the master and end
in this configuration.

Direct data

Data delivered in a single message. A SynchLink message can allocate
a maximum of four words. Direct data can be automatically forwarded
to the next node in the daisy chain configuration.

Disable keying

Option that turns off all electronic keying to the module. Requires no
attributes of the physical module and the module configured in the
software to match.

Download

The process of transferring the contents of a project on the
workstation into the controller.

Electronic keying

A system feature which makes sure that the physical module attributes
are consistent with what was configured in the software.

Exact match

An electronic keying protection mode that requires the physical
module and the module configured in the software to match
identically, according to vendor, catalog number, major revision and
minor revision.

Field side

Interface between user field wiring and 1/0 module.

End node

A node in SynchLink Star and Daisy chain configurations that only
receives data.



Glossary 3

Inhibit

A ControlLogix process that allows you to configure a SynchLink
module but prevent it from communicating with the owner controller.
In this case, the controller does not establish a connection.

Hub

Distribution unit in the star configuration that consists of a single base
block and up to 4 splitter blocks. Unidirectional data passes through
the hub.

Listen-only connection

An 1/0 connection that allows a controller to monitor 1/0 module
data without owning the module.

Major revision

A module revision that is updated any time there is a functional
change to the module resulting in an interface change with software.

Master node

A node in any SynchLink configuration that serves as the time master
and begins the SynchLink system.

Minor revision

A module revision that is updated any time there is a change to the
module that does not affect its function or software user interface
(e.g. bug fix).

Owner controller

The controller that creates and stores the primary configuration and
communication connection to a module.

Receive port communications format

The communications format used in a ControlLogix SynchLink module
for all data the module receives.
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Remote axis data

Motion data used by the motion planner in the controller. The
1756-SYNCH module can consume an Axis tag from a controller and
pass it over SynchLink. A controller in another chassis can then
consume axis tags passed over SynchLink from the 1756-SYNCH
module in that chassis.

Removal and insertion under power (RIUP)

A ControlLogix feature that allows a user to install or remove a
module while power is applied.

Requested packet interval (RPI)

A configurable parameter which defines when the module will
multicast data.

Ring Configuration

SynchLink configuration that begins with the master node.
Unidirectional data passes from the master node to up to nine other
nodes and then back to the master node.

RSLogix 5000
The programming software for any ControlLogix system.
Star configuration

A SynchLink topology where a hub is the physical center of the link,
and SynchLink nodes are connected to the hub. Each node has its
own direct, dedicated line to the hub. The hub acts as a multi-port
repeater and contains one receive and up to 16 transmit ports. The
Producer/Master node transmitter is connected to the hub receiver.
The receiver of each of the Consumer/Slave nodes is connected to an
appropriate hub transmitter. The Producer/Master node transmitter
and Consumer/Slave node transmitters are not connected. Messages
transmitted by the Producer/Master node are retransmitted (repeated)
simultaneously to all Consumer/Slave nodes.

SynchLink

A unidirectional fiber optic communications link that provides time
synchronization and data broadcasting. These functions are used for
distributed motion and coordinated drive control systems based on
ControlLogix and PowerFlex™ 700S products.



Glossary 5

Synchronize

A process where multiple devices operate at the same time or
maintain a matching time reference.

Time master

A device (e.g. SynchLink module) that is configured to establish the
time reference for a ControlLogix chassis or SynchLink system.

Time relay

A device that is configured to pass a time reference between a chassis
backplane and a SynchLink fiber.

Time slave

A device (e.g. SynchLink module) that is configured to receive the
time reference from the CST Time Master (located in a ControlLogix
chassis) or upstream node in a SynchLink system.

Timestamp

A ControlLogix process that stamps a change in input data with a time
reference of when the change occurred.

Transmit port communications format

The communications format used in a ControlLogix SynchLink module
for all data the module transmits.
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Notes:
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